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PREFACE

Research is very vital part in Academics. Academician publish their research work
in form of research papers, articles, case studies, Monograph etc. Data analysis has a
major role to play in research and researchers use various software and packages to
do Data Analysis. Statistical Package for Social Sciences is one such package which
researchers are using for data analysis. This Monograph demonstrates how one can
use the statistical techniques to analyse the data using SPSS. This Monograph is an

effort to present the concepts and techniques in a very simple manner.

Shiney Chib, Ph.D.
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Chapter 1
Introduction to SPSS

SPSS (Statistical Package for Social Science) is a powerful and easy-to-use software
program for data manipulation and data analyses. The advantages of SPSS is that it allows
the researcher to manipulate and analyze data via syntax commands or through a visual
data editor.

Click START -->ALL PROGRAMS-->SPSS Inc.-->SPSS 20.0
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For New File creation:
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Click FILE >NEW->DATA
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For Existing File:

Click FILE >OPEN->DATA

You will get the results as shown below:
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GETTING FAMILIAR WITH SPSS

> DATA AND VARAIBLE EDITOR:

For New File creation:

Click FILE >NEW->DATA

e, . T oo
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» OUT PUT WINDOW
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» TOOLBAR

The TOOLBAR below Menu bar provides a quick and easy access to the different features.
He M~ Bl H 5K BoOHE {9

= Open data document-->to open particular data file

= Save the document-->to save particular data file
= Print-->to print a particular data file

» Recall recently used dialogues-—>shows a list of recently opened dialogue boxes, for easy
and handy access. Undo a user action-->to undo user action

= Redo a user action-->to redo user action

= Goto case-—>to go to a particular variable by directly typing the name of variable or
selecting it from a drop down list.

» Goto variable-—>to go to a particular variable by directly typing the name of variable or
selecting it from a drop down list.

* Variables-—>provide data definition for all the variable in the current data file.
* Find -->to search particular data in the existing data editor.

* Insert cases-—>to insert a case above the active cell case.

* Insert variable-—>to insert a variable to the left of active cell variable.

= Split File->to split a file into separate groups.

= Weigh Cases-—>to give different weighs to cases for statistical Analysis.

= Select Cases-—>to select varied criteria to be used in case selection. It provides several
methods for selecting groups/sub groups of cases based on some criterion.

= Value Label-—>It allows toggling between value labels and actual values in the Data Editor.
= Use Variable Sets-~>used to select particular sets of variables in the current data file.

=  Show all variable-—>used to see all variables in the current data file.
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= Spell Check-—>used to check spelling in the current data file.

» MENU BAR

The features of main MENU bar are as follows:

File Edit Wiew Data Transform Analyze DirectMarketing Graphs Utilities Add-ons  Window Help

FILE MENU

The FILE MENU allows creating new files, opening existing files, read text data, save files,
print and other basic starting or output activities. You can exit SPSS through this menu.
This menu resembles the FILE MENU features of Ms-word.

File Edit View Data Transform Analze DireciMarkeing Graphs Utiiies Addons Window Help
e BB = W s
Bl N AN EBLE 00 %
Open Datapase »

(@ Read Texd Data tion | Income | Profession | Pro Type | Bank |Accountty.| Cad | Ebanking | Use | var | var | var | var | var
o
H

New

Open »

|visiote: 11 01 11 variables

Save As
L]
i Export to Database.
\"@ Mark File Read Only
[ Rename Dataset
Display Data File Information »
= Gache Data
]
S Switch Server.
Repository »
R
[ )
Recently Used Data »
Recently Used Files »

Exit

gl

EDIT MENU

The EDIT MENU allows to cut,copy, paste from the output or windows clipboard. It also
allows to redo/undo any action. You can also inert/goto variable or case through this
Menu.
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Edit View Data Transform

| o
=l
S cut Ctrl+x
=y copy Ctri+C
& Clear Delete

Insert Variable
B Insert Cases

Bl Find... Ctri+F
s
= Replace... Ctri+H

K& Goto Case...
& Goto variable...
]

[=f Options...
VIEW MENU

The VIEW menu allows to activate/deactivate the status bar and other toolbars. You can
change fonts, grid lines, value label.

Wiew Data Transform Analyze Direc

«  Status Bar
Toolbars b
Menu Editor...
Fonts...
) Grid Lines
1.& Value Labels
]
B

B variables Crl+T

DATA MENU

The DATA Menu allows you to define variable properties, dates, multiple response sets. It
also allows in identifying duplicate cases, sorting cases/variables, transposing,
restructuring and aggregating data along with other functions. You can also merge files,
split a file, select and weigh cases through this menu.
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Data Transform  Analyze Direct Marketing

[.3 Define Variable Properties...
2. Set Measurement Level for Unknown...
= Copy Data Properties ...
=
£ Define Dates. .
Drefine Multiple Response Sets..
Validation »
% Identify Duplicate Cases._.
FJ Identify Unusual Cases...
= Sort Cases ..
E& SortVariables...
F=f Transpose...
Merge Files »
E=H Restructure. ..
EEs Aggregate...
Crthogonal Design »
5, Copy Dataset
E= splitFile...
Egelec‘[ Cases..
Iﬂiﬂeight[:ases...

TRANSFORM MENU

TRANSFORM menu allows creating new variables using compute variable and helps in
changing variables in the data file through recode, rank case and many others.

Transform  Analyze Direct Marketing  Graphs

B compute Variable... i
Count Values within Cases...
Shift Values. .. L
Recode into Same Variables...
[2] Recode into Different Variables...
El Automatic Recode. ..
[}8 visual Binning...
[> Optimal Binning...
Prepare Data for Modeling P
B-H Rank Cases...
E Date and Time Wizard...
[ Create Time Series ...
B Replace Missing Values...
@ Random Number Generators...

_\‘:.'
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ANALYZE MENU

ANALYZE menu allows the analysis of data label based on various statistical tools and
techniques.

Analyze Direct Marketing Graphs

Reports »
Descriptive Statistics
Tables

Compare Means

General Linear Model
Generalized Linear Models
Mixed Models

Correlate

Regression

Loglinear

Meural Networks

Classify

Dimension Reduction
Scale

Monparametric Tesis
Forecasting

Survival

*¥ ¥ ¥ ¥ Y Y Y YT T Y YT T T T T

Multiple Response
Missing Value Analysis...

Multiple Imputation

Complex Samples 3

Quality Contral »
ROC Curve...

IBM SPSS Amos...

GRAPHS MENU

The GRAPH menu allows you to create bar chart, line chart area chart, pie chart, histogram,
scatter plots along with many other variations.

Graphs Utlifies Add-ons Window

jill Chari Builder.
@ Graphboard Template Chooser..
Legacy Dialogs )

UTILITIES MENU

The UTILITIES menu helps in using various other utilities, which may or may not be
required in normal usage. This menu shows data file comments, allows define or use
different variable sets and spell check.
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Utilities  Add-ons  Window H

ﬁ Variables...

55 OMS Control Panel...
=) OMS |dentifiers...

éﬂ Scoring Wizard...

5 Merge Model XML...
f<f Data File Comments...
# Define Variable Sets...
(& Use Variable Sets...

E@ Run Script...

Production Facility...
Map Conversion Utility...
Custom Dialogs k

Extension Bundles »

ADD-ONS MENU

The ADD-ONS menu provides a list of various add-on features requisite for special
requirements and are mostly meant for advanced level users.

Add-ons  Window Help

Applications r
Senvices b
Programmability Extension

Statistics Guides 3
WINDOWS MENU

The WINDOWS Menu allows you to arrange, select and control the attributes of various
windows. Through this menu, you can easily split a window, minimize all windows or
switch over between the various open windows.

Window  Help

=Rl

Minimize: Al Windows

1 *Qutput! [Document]- 1BH SP33 Stafistics Viewer

¢ 2 FINALDATA 53y [Datadet]- IBH 833 Statsfics Data Editor
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HELP MENU

The HELP Menu allows you to access the information related to usage of various features of

SPSS.

Help
| @ Topics
1 @ Tutorial

Case Studies

Statistics Coach

Command Syntax Reference
8P5S8 Community

About...

Algorithms

IBM SPSS Products Home

» CREATING A DATA FILE

EXAMPLE DEMONSTRATION.

Lets discuss the data file creation. A close ended questionnaire is defined for knowing the
consumer preference with respect to mobile phones. The questions were: Age , Gender,
Qualification, Occupation, Monthly Income, Residence, Mobile Brand Preference.

DEFINING VARAIBLES:

In order to define variables based on questionnaire, following points need to be taken into
consideration:

Must begin with a letter.

Cannot end with full stop or underscore.
Must be unique; duplication not allowed.
Blanks and special characters cannot be used.
Length of name cannot exceed 64 bytes.

Reserve key words (like AND,ALLNOT,OR TO, WITH) cannot be used as variable
names.

Names are not case sensitive. They can be written in upper or lower case.

Long variable names need to wrap to multiple lines in the output, so SPSS attempts to break
lines at underscore, periods and a change from lower to upper case.
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VARIABLE TYPE

You can select variable type according to your requirement. By default numeric variable
type with eight width and 2 decimal is chosen by SPSS. You can also change the width and
decimal places.

File Edit View Data Transform Analyze DirectMarketing Graphs Ulilities Add-ons Window Help

SH N~ BLINBEFECTM 10

| Name " Type H Width H Decimals H Label ‘l Values H Missing " Columns " Align H Measure H Role
1 £
2
3}
4
s N
5 3 Variable Type ==
6
7 i ol
© Comma
g oo wan ]
9 25 ;
Decimal Places: |2
10 © Scientific notation - _
1 © Date
12 © Dollar
13 © Custom currency
1 © string
15 @ Restricted Numeric (integer with leading zeros)
16
.“ The Numeric type honors the digit grouping setting, while the Restricted
i X numeric never uses digit grouping
18
s (Lox J cancat
20 b
21
22
23
24
25 =
[ETI IF]
DalaView || variable View

[ |IBM SPSS Statistics Processoris ready | | | | |

- B ) 525AM

MOBILE PHONE---BRAND PREFERENCE

1. AGE: 1)Below 30 2)30-35 3)35-40 4)40-45
5)45-50 6)Above 50

2. GENDER: 1) Male 2)Female

3. QUALIFICATION:1)Under graduate 2)Graduate 3)Post Graduate 4)MPhil
5)PhD.

4. OCCUPATION : Student( ) Business( ) Service ( ) Others( )

5. MONTHLY INCOME : Less than 20000( ) 20000-30000( ) 30000-40000( )
Above 50000( )

6. RESIDENCE:Metro( ) Non-Metro( ) Rural( )
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SONY ( ) OTHERS( )

7. MOBILE BRAND PREFERENCE : IPHONE ( ) SAMSUNG ( ) BLACKBERRY ( )

CODE BOOK

SR.NO.

VARIABLE NAME

VALUE/CODE

AGE

1=<30
2=30-35
3=35-40
4=40-45
5=45-50
6=>50

GENDER

1=MALE
2=FEMALE

QUALIFICATION

1=UNDER GRADUATE
2=GRADUATE
3=POST GRADUATE
4=MPHIL

5=PHD

OCCUPATION

1=STUDENT
2=BUSINESS
3=SERVICE
4=0THER

MONTHLY INCOME

1=<20000

2=20000-30000
3=30000-40000
4=40000-50000
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5=>50000
6 RESIDENCE 1=METRO
2=NON METRO
3=RURAL
7 MOBILE BRAND 1=IPHONE
PREFERENCE
2=SAMSUNG

3=BLACKBERRY
4=KARBON
5=SONY
6=0THERS

SUMMARY :

e For New File creation: Click FILE 2?NEW 2>DATA

e In case of defining variables you must take care of naming, labels, variable type,
column format and measurement level.

e Once entries are made, you can save the data file. Just click FILE Menu-->Save and
click will open the save data as dialogue box. Enter the name of file, choose the
location to save the file and press save.

e For Existing File:Click FILE OPEN >DATA

EXERCISE

Create a data file with the following variable and their information.

Sr.No. Variable Name Information
1. Gender Male
Female
2. Age Below 20
20-30
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30-40
40-50
Above 50

3. Education

Under graduate
Graduate
Post graduate

Doctorate

4, occupation

Student
Business
Service

others

5. Monthly salary

Less than 30000
30000-40000
40000-50000
Above 50000

6. Usage of Plastic
Bags should be
banned.

Strongly Disagree
Disagree

Neutral

Agree

Strongly agree

kokskokskoksk sk sk sk sk kskkk
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Chapter 2
Descriptive Statistics

Descriptive statistics are used to have a basic view of the data, i.e. to describe the data, like
how many respondents were there, how may male, how many female, the average age
range, what is the median salary etc.

Frequency Distributions:

There are display of the frequency of occurrence of each value. The frequency distribution
can be represented in tabular or graphical form

e For continuous variable with ratio/interval scales, histogram or frequency polygons
may be used.

e For categorical variables with nominal/ordinal scales, bar chats can be used.

e Measures of Central Tendency

e The measures are mainly useful with interval or ratio scales.

e There are three main measures of central tendency, that is mean, median and mode.

e The measures of variability include range, interquartile range, standard deviation
and variance.

WORKING EXAMPLE:

Lets discuss descriptive statistics with a working example.

Sr.No. Variable Name Information
1. Gender Male
Female
2. Age Below 20
20-30
30-40
40-50
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Above 50

3. Education Under graduate
Graduate
Post graduate

Doctorate

4. occupation Student
Business
Service

others

5. Monthly salary | Less than 30000
30000-40000
40000-50000
Above 50000

8 Ut ot - o 55 S s ™ e |

File Edit View Dala Iransform Anabze DirectMarkeling Graphs Ulillies Add-ons Window Help

i i BOE 10 ® ¢
SHe M~ BLE2 W EE BLE oI 6
Name | Type | Width | Decimals|  Label | Values | Missing | Columns |  Align | Measwe |  Role
[sender | Numeric Gender {1, Male}. None = Center & Nominal ™ Input ]

6 0 6
Age Numeric 6 0 Ageinyears (1. Below2.. None 8 =center il Ordinal N Input
Education  Numeric 6 0 Highest Educat... {1, Undergra... None 8 =Center & Nominal N Input
6 0 8
8 0 8

Oceupation {1, Student]... None = Right Unknown N Input
Monthly Salary {1, Less tha... None = Right Unknown N Input

Salary Numeric

z
2
3
4 Occupation  Numeric
5
6
7
8

[E1] ID
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Form the data file and enter the data as shown below

-
>

3 "descriptive sav [DataSetl] - [BM SPSS Statistics Data Editor B

File Edt View Data Iransform Analze DirectMarketing Graphs Utiities Add-ons Window Help

o | |

Visible: 5 of 5 Varia

SHE M e~ BLAKFEE Boi 0%
[1

25 salary

bles

var var var var var var

Gender

1

Age Education | Occupation

1

Salary

1
2
2
3
4
5
2
2
2
1
2
3
2
4
3
4
1
5
2
3
3
3
2

[ P P G S Y Y B g ) B O N I S
Wi R R R s R R R W w R R R o

Lo w o mwaomomomoma b wanha oo

1
1
1
1
1
1
1
2
2
1
2
2
1
1
1
1
2
1
2
1
2
2
1

[T

T

1Bl SPSS Statistics Processoris ready | |

We are ready to analyze the data and see the descriptive statistics. The fre

distribution display the frequency of occurrence of each score value.

a
5:23 AM

quency

This can be

represented in tabular and graphical form. In case of continuous variables (measured on
ratio or interval scale) histogram or frequency polygon are appropriate. In case of
categorical variables (measured on nominal or ordinal scale) bar charts are suitable. Main
measures of central tendency are mean, median and mode. The measures of variability
include range, interquartile range, standard deviation and variance. These measures of

variability are more suitable for interval or ratio data.

In order to the analysis:

Click Analyze 2> Descriptive Statistics>Frequencies

This will open Frequencies dialogue box.
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1A *descriptive.sav [DataSet1] - IBM SPSS Statistics " E=nro )
File Edit View Data Transform Analze DirectMarketing Graphs Uiiies Add-ons Window Help
0 7 Reports 3 = =] LYg Al
BSHEe @M « SE 19% %
: Descriptive Statistics » Ererms =
25 Sala 1 - Visible: 5 of 5 Variables
£ Tl C Descriptives.. ‘
| Gender | Age | Compare Means * | & B . L ar | var [ var [ var [ var | var [ var | var [ var |
1 1 1 General Linear Model >
= [EE Crosstabs
2 1 2 Generalized Linear Models b
Ratio
3 1 2z Wixed Models [ Ry
4 1 3 Corelate 3 E-P Plots
5 1 4 Regression » B aqPiots
5 ! s Loglinear » 1
i ! 2 Neural Networks » 3
8 1 2 2
Classify 3
9 2 2 4
Dimension Reduetion  »
10 2 1 = 1
Scale »
n 1 2 - 5
e 2 3 MNonparametric Tests 3 5
3 2 2 Forecasting N
) B 4 Sunival » 5
3 1 3 Hultiple Response 1
16 1 4 [EZ Missing Value Analysis. 5
17 1 1 Hultiple Imputation » 1
18 2 5 Complex Samples » 3
19 1 2 Quality Control v o2
20 2 3 [ Rroc cune 2
2 1 3 1BM SPSS Amos 3
22 2 3 2
23 2 2 1 3 1
2 4 2 P 1
El v

[

ey

|Descriptive Statistics

% e

=
% b 524AM

@ Frequencies

|_& Gender [Gender] |
Jl Age in years [Age]

&5 Highest Education [ ..

&% Occupation [Occupa...
&% Monthly Salary [Sala...

[+ Display frequency tables

Paste

.-\l
LA,

Variable(s):

Select the variable you wish to compute. In order to select a variable,

click on that variable in left side box—>click the right arrow button between the two
boxes—>the variable will shift to the right side in Variables list box

Similarly do this for all the variables.
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-

'!?';“ Frequencies

Variable(s):

=
&5 Cender [Gender]

E[IAge in years [Age]
&5 Highest Education [..

& Cccupation [Occupa... =
& Wonthly Salary [Sala._|| (B20iSirap...

[ Display frequency tables

[ ok || Paste || Reset || cancel || Help |

Now click Statistics button: a sub dialogue box will appear on the screen. Click check box,
as desired. In this working example , we have selected various statistics based on the
following figure. After selecting click continue. The sub dialogue box will be closed and
previous dialogue box will reappear.

r@ Frequencies: Statistics I&q
Percentile Values Central Tendency
[] Quartiles [ Mean
[T] Cut points for: equal groups [ Median
] Percentie(s) ¥ Moge
[] Sum

[] values are group midpoints

Dispersion Distribution
[/ Std. deviation [& Minimum [7] skewness
[+ variance [ Maximum [] Kurtosis
[¥ Range [[] 58.E. mean

[Continue][ Cancel ][ Help ]

— ——

Click Charts button to open its sub dialogue box. Click the radio buttons, as desired. In
this working example we have selected radio button based on the following figure.
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Publication Partner:

-

+2 e
& Frequencies #a Frequencies: Charts &

[ Display fre

Chart Type

©) Pie charts
© Histograms:

Chart Values

® Frequencies © Percentages

[Cuntinue][ Cancel ][ Help ]

"

Statistics...
Charts...

Format...

Bootstrap...

b4

After selection click continue. The sub dialogue box will be closed and previous dialogue
box will reappear. In this dialogue box click OK to open the Output viewer.

» OUTPUT

Frequencies

[DataSet1] C:\Users\SHINY\Desktop\phd-coursework\SPSS-SHINY\descriptive.sav

Statistics
Gender Age in Highest | Occupatio| Monthly
years Education n Salary
Valid 25 25 25 25 25
Missing 0 0 0 0 0
Mean 1.32 2.56 2.28 2.00 2.40
Median 1.00 2.00 2.00 2.00 2.00
Mode 1 2 3 2 2
Std. Deviation 476 1.158 936 .645 1.384
Variance 227 1.340 877 417 1.917
Range 1 4 3 2 4
Minimum 1 1 1 1 1
Maximum 2 5 4 3 5
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Frequency Table
Gender
Frequency | Percent Valid Cumulative
Percent Percent
Male 17 68.0 68.0 68.0
Valid Female 8 32.0 32.0 100.0
Total 25 100.0 100.0
Age in years
Frequenc | Percent Valid Cumulative
y Percent Percent
Below
25 4 16.0 16.0 16.0
25-35 10 40.0 40.0 56.0
. 35-45 24.0 24.0 80.0
Valid
45-55 3 12.0 12.0 92.0
Above
cc 2 8.0 8.0 100.0
Total 25 100.0 100.0
Highest Education
Frequenc | Percent Valid Cumulative
y Percent Percent
Undertiradua 6 24.0 24.0 24.0
Graduate 8 32.0 32.0 56.0
Valid gr:(‘;j;te 9 36.0 36.0 92.0
Doctrate 2 8.0 8.0 100.0
Total 25 100.0 100.0
Occupation
Frequenc | Percent Valid Cumulative
y Percent Percent
Student 5 20.0 20.0 20.0
Valid Business 15 60.0 60.0 80.0
Service 5 20.0 20.0 100.0
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Total 25 100.0 100.0
Monthly Salary
Frequenc | Percent Valid Cumulative
y Percent Percent
Less than
20000 7 28.0 28.0 28.0
20000-30000 10 40.0 40.0 68.0
Valid 30000-40000 3 12.0 12.0 80.0
40000-50000 1 4.0 4.0 84.0
Above 50000 4 16.0 16.0 100.0
Total 25 100.0 100.0
Bar Chart

Gender

Age in years

Frequency

T T T T T
Below 25 25-35 3545 4555 Above 55

Age in years
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Highest Education

-
g e
c
o
3
o
o
2
'
4
2
o T T T T
Undergraduste Gracugte Post graduste Doctrate
Highest Education
Occupation
15
104
-
I
c
3
Fl
o
o
2
'S
=
o T T T
Student Business Service
Occupation
Monthly Salary
10-]
.
o
c
@
3
3
o
'S
4
.
T T T T T
Lessthan 20000 20000-30000 30000-40000 40000-50000 Aove 50000

Monthly Salary
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For normal curve:

Click histograms - click normal curve.

Histogram
109 Mean = 2.56
Std Dev.=1158
=25
.
s
c
@
3
o
a
i
('
+
.
o T T T T T T T
0 1 2 3 4 5 5

Age in years

In order to start further analysis through descriptive,

click Analyze menu->Descriptive Statistics—=> Descriptive

This will open Descriptive dialogue box.

Analyze DirectMarketng Graphs Utilties Add-ons W

Reports

Descriptive Statistics [ Frequencies

Tables [Z] Descriptives...

A Explore

E Crosstabs...
Ratio

[ P-P Plots..
B3 c-a Plats

Compare Means

General Linear Model
Generalized Linear Models
Mixed Models

Caorrelate

Regression

Loglinear

Neural Networks
Classify

Dimension Reduction
Scale
MNonparametric Tests
Forecasting

Survival

Multiple Response
Missing Value Analysis...

Multiple Imputation »

Complex Samples

Quality Control 2
ROC Curve

IBM SPSS Amos.

DL M M W N R o s B R W
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-

2 Descriptives ot o]
Variable(s). - 1
Options.
&> Gender [Gender] -

& Highest Education |

ol Age in years [Age] -ﬂootstrap._ |
&> Occupation [Occupa.. 1
&5 Monthly Salary [Sala E]

[F] Save standardized values as variables

=

Select the variables, you wish to compute. In this working example we have selected all the
five variables. In order to select a variable, click on that variable in left side box—>click the
Right Arrow button between the two boxes. The variable will shift to the right side in
Variables list. Similarly, do this for all other variables. Now click ‘Save Standardized
values as variable’ check box to save the standardized z-scores for further computation

(like interaction terms in multiple regression) or in comparing samples from different
population.

£

-
13 Descriptives &J
Variable(s):

& Gender [Gender]
41 Age in years [Age] Bootstrap...

&3 Highest Education [

&) Occupation [Occupa..
& Monthly Salary [Sala...

[7] Save standardized values as variables

[_ok ][ paste |[ Reset | [cancel][_Help |

Now click Options button to open its sub dialogue box. Click the check boxes, as desired.
After selection click continue.

't,-'l Descriptives: Options Lé]

[ Mean ] Sum
Dispersion

[+ Std. deviation [+ Minimum
i : (¥ Maximum

[] Range [] S.E. mean

Distribution i

[ Kurtosis ~ [] Skewness

Display Order

@ Variable list

© Alphabetic

© Ascending means
rl © Descending means |

[Continue][ Cancel H Help ]

In current dialogue box click OK to open the Output Viewer.
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Descriptives
Descriptive Statistics
N Minimu | Maximu | Mean Std. Varianc
m m Deviation e

Gender 25 1 2 1.32 476 227
Age in years 25 1 5 2.56 1.158 1.340
nghesF 25 1 4 2.28 936 877
Education

Occupation 25 1 3 2.00 .645 417
Monthly Salary 25 1 5 2.40 1.384 1.917
Vzlalhd N 25

(listwise)

SPSS provides graphical and semigraphical techniques collectivel referred as exoloratory

data analysis (EDA). EDA is useful for describing the characerstics of a dataset, identifying

outliers and providing summary descriptions. Most widely used EDA techniques are box

plots and stem and leaf displays.

Click Analyze—> Descriptive Statistics>Explore

Analyze Direct Marketing Graphs  Utilities Add-ons W

Reports

Descriptive Statistics
Tables

Compare Means

General Linear Model

Generalized Linear Models

Mixed Models
Correlate
Regression
Loglinear
Meural Networks
Classify
Dimension Reduction
Scale
Monparametric Tests
Forecasting
Survival
Multiple Response
Missing Value Analysis...
Multiple Imputation
Complex Samples
Quality Control
ROC Curve...
IBM SPSS Amos..

3
3
b
b
3
L3
L3
L3
2
2
2
2
2
2
2
2
2
2

-

[ Frequencies...
[&] Descriptives...
A, Explore...
@grosstabs .
[F] Ratio...

|2 P-P Plots...
& a-a Piots...

=

VI T T FUTR N T G TR TR G TR ST S T SN L TR Y J ey
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r Explore

Dependent List:

|i| Age in years [Age] | &) Monthly Salary [Sala...
&> Highest Education [... -
&5 Occupation [Occupa... @

Factor List:

&> Gender [Gender]
Label Cases by:
I

Display
{@ Both © Statistics © Plots

e

@ Explore Q Explore: Plots

Boxplots ———— Descriptive

£ Age ] @ Factor levels together | | [ Stem-and-leaf

&> Highe (© Dependents together [7] Histagram
& Occuply
@ Mone

[l ENgrmaIity plots with tests |

Spread vs Level with Levene Test
@ Mong

(@ Power estimation

Display— @ Transformed Power |Natural log -
©® Both @ Untransformed

\Continue) | cancet || Hetp_|

[ o ——
T —
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Monthly Salary
9

1

T T
Male Female

Gender

EXERCISE
Gender Age group Education Work experience
group
Female 25-30 Under graduate Below 3 years
Male 30-35 Graduate 3-5 years
35-40 Post graduate 5-10 years
40-45 Above 10 years
45-50

Calculate descriptive statistics. Draw pie chart for each observation. Test the Normality,
using Histogram.

Skoksk sk sk sk sk skosk sksk skok sksksksk sk ok sk
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Chapter 3
Transforming Data

Windows can transform the values in several ways. SPSS for Windows can:

» Combine values of a variable into several categories,

» Create new variables out of old variables,

» Select particular cases and analyze only these cases,

» Weight cases so that some cases count more heavily than others.

SPSS provides many ways to transform data: recode, compute, if, and weight.

Recoding Variables

Recoding is a way of combining the values of a variable into fewer categories. Let me give a
hypothetical example. Let's say you have conducted a survey and one of
your demographic questions was the age of the respondent. Entering the actual age in
years would be the simplest way of working with the data. But let’s also say that you want
to compare people of different age groupings. In other words, your data would be more
useful if it was organized into collapsed categories, like "Young", "Middle age", and "Older".
Using SPSS for Windows you could reorganize the data so that you had these three
groupings. There are two things you need to know before you recode the values.

e First, you need to decide the number of categories you want to end up with.
e Generally this will be determined by the way you plan to use the information.

If you are going to analyze the data using a table where you cross-tabulate two variables ,
you probably want to limit the number of new categories to three or four. The second thing
you need to know is which of the old values are going to be combined into a new category.
For example, you might do something like this.
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The actual age of the respondent as | The new, collapsed, category.
originally recorded in the data file.

L Young
18 years through 35 years

- Middle age
36 years through 55 years

- Older

56 years of age or over

Another example might be if respondents were asked how often they prayed, and the
original responses were several times a day, once a day, several times a week, once a week,
less than once a week, once a month, once a year, or never. With recode we can combine
the people who said “several times a day” with the people who said "once a day" and put all
these respondents into a new category which we could call "a lot". Similarly, we could
combine the people who said "several times a week" with those who said "once a week"
and call this category "sometimes" and combine those who said "less than once a week"
and "once a month" and call this category “infrequently”. Those who said "once a year" or
"never" could be combined into a fourth category called "hardly ever". Recoding is the
process in SPSS that will do the above examples.

> WORKING EXAMPLE :

Please note that in the below table,

1| First column indicates the respondent number

2| Second column indicates the preference for fast food. The respondents
were asked to state their preference for fast food on a 5-point scale where
1 = not at all preferred, 2 = not preferred, 3 = neutral, 4 = preferred, 5 =
very much preferred.

Third column in the table indicates the actual age of the respondent

4| Fourth column of the table states the household monthly income coded as:
1 = Household income less than Rs.25,000/- per month (low income)

2 = Household income of Rs.25,000/- per month but less than Rs.50,000/-
per month (middle income)

3 = Household income of Rs.50,000/- & above (High income)

5| Fifth column

1=Male

2=Female

w

Data Table:

Resp No. | Preference | Age Income | Gender
1 1 46 2 2
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2 2 24 1 1
3 4 22 3 1
4 4 18 3 1
5 2 46 1 1
6 2 38 1 1
7 1 47 1 2
8 2 54 2 2
9 5 50 3 2
10 4 46 3 1
11 3 29 1 1
12 2 32 2 2
13 4 26 2 1
14 5 19 2 1
15 4 41 3 1
16 2 20 1 1
17 3 36 2 2
18 4 31 3 1
19 5 28 1 2
20 2 54 1 1
21 4 30 1 2
22 2 46 2 1
23 3 37 3 1
24 4 22 3 2
25 3 26 1 2
26 4 47 3 2
27 3 45 1 2
28 2 50 1 1
29 2 54 2 2
30 5 26 3 2
31 3 41 1 1
32 5 42 2 1
33 1 61 3 1
34 2 31 1 1
35 1 19 3 1
36 3 20 1 1
37 4 29 3 2
38 3 26 2 1
39 4 31 3 1
40 4 28 3 2
41 3 41 2 2
42 2 51 1 1
43 1 49 1 1
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44 5 31 3 1
45 3 46 2 1
46 4 26 1 1
47 5 31 3 1
48 4 35 2 1
49 5 32 3 2
50 4 39 3 2
51 1 52 2 1
52 3 46 1 2
53 2 21 2 1
54 4 21 3 2
55 5 18 3 1
56 5 29 2 2
57 4 51 3 1
58 1 52 2 2
59 2 46 2 2
60 2 31 1 2
61 3 34 3 2
62 3 46 3 1
63 4 60 3 2
64 4 18 3 2
65 5 27 2 1
66 5 25 3 2
67 2 31 1 2
68 1 32 3 1
69 3 47 3 1
70 5 42 2 1
71 1 59 3 1
72 2 50 3 2
73 3 26 1 2
74 4 28 3 1
75 5 31 2 2
76 5 52 2 1
77 4 41 3 2
78 3 38 1 1
79 2 46 2 2
80 1 41 3 1
81 3 46 2 1
82 5 24 3 2
83 3 44 1 2
84 4 27 2 1
85 2 58 2 1
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86 1 56 1 1
87 4 29 3 2
88 3 52 3 2
89 4 26 3 2
90 3 24 2 2
91 5 42 3 1
92 5 34 3 1
93 4 22 3 2
94 2 22 3 2
95 3 26 2 1
96 2 38 2 2
97 4 33 3 1
98 4 33 3 2
99 5 28 1 2
100 1 19 3 2

Another example might be if respondents were asked how often they prayed,
and the original responses were several times a day, once a day, several times
a week, once a week, less than once a week, once a month, once a year, or
never. With recode we can combine the people who said “several times a day”
with the people who said "once a day" and put all these respondents into a
new category which we could call "a lot". Similarly, we could combine the
people who said "several times a week" with those who said "once a week"
and call this category "sometimes" and combine those who said "less than
once a week" and "once a month" and call this category “infrequently”. Those
who said "once a year" or "never" could be combined into a fourth category
called "hardly ever". Recoding is the process in SPSS that will do the above
examples.

Create a SPSS file for the above data as shown below.

» VARIABLE VIEW
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{8 " s 955 s o el I

File Edt View Data Transform Anabze DirectMarkefing Graphs Utiiies Add-ons Window Help

SHe B e~ ELAHE

=5

119 ® %‘

1
2
3
4 Gender
5]
6
7
8
9

| Name H Type H Width H Decimals H Label ‘l Values ‘l Missing H Columns H H Measure H Role
Preference  Numeric 2 0 . Mot at all_ 99 i M ordnal =] ™ Input
Age Numeric 2 0 None 99 11 & Nominal N Input
Income Numeric 8 0 None 99 " & Nominal N Input

Numeric 1 0 None 99 " & Nominal N Input

> DATAVIEW

@ e i S e

Fle Edi View Dala Transom Anale DirectMarkeling Graphs  Uliiies

Asdons  Wn

[1BM 5P

B W W el

Help

=

SHO M~ BLINSEBLE 400 %

o |

Visible: 4 of & Variables

| Preference

Age

Income

Gender

var var ar var var var var ar var var var

e

-

S N R O P S 0 O 0 PSP R PO PP G Y (O P P )

BYsesn3aeliaygissnsys

P S T U0 S [P S Y

1EM SPSS Siatistics Processor s ready

Click on "Transform" = "Recode".
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Your screen will look like:

8 s st S S
Fle £t View Dala Iransm Analge DiectMameling Grapns Ubiilies Addns Window  Help
';f ﬁ éﬁ i B Gompute Vaniable. % g % ':. j ﬂ% -:,; P rg
1 [E CountValues within Cases == =
— Visible: 4 of 4 Variables
: PreeIenc o oo nt Same varabes. Bender | e ar ar = ar ar e ar A ar il
= [ Recode into Dierent variabies... i |
3 [ sutomatic Recods. 1
4 [ visual Binning. 1
5 < opamal Binning... 1
6 Prepare Data for Modeling » 1
U EA Rank Cases._ 2
t £ Date and Time Woard... z
::‘ [E Create Time Series. i
T 5 Replace Missing Values. 1
12 @ Random Number Generators... 2 |
1 B 1
i s w7 1
15 4 B 3 1
% 2 2 1 1
17 3 £ 2 2
18 4 31 3 1
19 5 2] 1 2
2 2 54 1
F 4 £l 2
2 2 4 2 1
] 3 £ 3 1 |
N s n Y 2 I
W 0]

Data View Variable View

Recode o Diferent Variabies. 1BH SPSS Stafisiics Processor is ready

Now we have two options:"Recode Into Different Variables" and "Recode Into Same
Variables".It is strongly suggested to use the "Recording Into Different Variables" option. If
you make an error, your original variable is still in the file and you can try again. If you
make an error using "Recode Into the Same Variables"”, you have changed the original
variable. If you also saved the file after doing this, and you did not have another copy of the
file, you have just eliminated any chance of correcting your error.

Recoding Into Different Variables

The recoding into a different variable starts with giving the new variable a variable name.
For example, Lets take ‘Preference’

If we recode into different variables we could combine the preference like

Not at all preferred=code 1, Not preferred=code 2, Neutral = code 3 as New variable-Not
preferred as code=1.

Preferred=code 4, Very much preferred=code 5 preferred as code=2.

To do that, click on "Into Different Variables". Your screen will look like:
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63 “Untited? (Dataset1) - M 5755 SEaERIeS Data L )

File Edit View Data Transform Analyze DirectMarketing Graphs Utiities Add-ons Window Help

B M e~ Bl B BaE 0% %
\

[Visible: 4 of 4 Variables

Preference || Age [ mcome [ Gender [ var [ var [ v [ v [ v | v [ va | e [ v [ v [ o
1 1 46 2 2 =]
2 2 2 1 1
g 4 2 [ Recode into Different Variables =)
4 4 18
5 2 46 Input Variable -> Output Variable: Outputvariable
6 2 8 | ll Preference ] s
& Age =
’ 1 47 &\nmme
i 2 54 %Gendev =
9 5 50
10 4 46
11 3 29
12 2 2
13 4 2
14 5 19 ——————
I 4 n Old and New Values
16 2 2 @(ﬂpﬁnna\ case selection conditian)
17 3 36
19 5 28 |
20 2 54 1 1
21 4 El) 1 2
22 2 46 2 1
23 3 Eld 3 1 | |
7 4 2 2 =
£ TF]
Data View | Variable View

[ [IBM SPSS Statistics Processoris ready | | | | |

=
< BT 200AM

Find ‘Preference’ in the list of variables on the left and click on it to highlight it, and then
click on the arrow just to the left of the big box in the middle of the window. This will move
Preference into the list of variables to recode. You want to give a name to this new variable
so click in the "Name" box under Output Variable and type the name "Preferencel" in this
box. You can even type a variable label for this new variable in the Label box just below the
Name box. Try typing "Age in Four Categories" as your label. Click on the "Change" button

to tell SPSS to make these changes. Your screen will look like as below.

File Edit View Data Transmvm Analyze DirectMarketing  Graphs  Utili d-ons W\HUDW Help
N &l Al
T ) *'3‘

5 K« Y

| ‘ Visible: 4 or 4 variables

Preference | Age [ mcome | Gender | var | va | wvar || var | va [ var [ v [ var [ var [ v [ v |
1 1 46 2 2
2 2 24 1 1
£ b 2z 'ﬂ Recode into Different Variables [==)
4 4 18
5 2 45 Numeric Variable -> Output Variable: Outputvariable
B 2 E3 & Age Preference — 7 ame
& Gender
8 2 54 Label
10 4 48 =
11 3 29
12 2 2
13 4 2
14 5 19
6 2 zn ‘(ODunnaIcasese\emuncunmlmﬂ) ‘
17 3 3
19 5 28 1L
20 2 54 1 1
21 4 30 1 2
2 2 46 2 1
23 3 a7 3 1
2 4 ” 2 =
€17 [¥]
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Now we have to tell SPSS how to create these categories. Click on the "Old and New Values"

button at the bottom of the window. The screen will look like :
8 Uit oot - S RO ™ Eaewe o meriws

File Edit View Data Transform Analyze DirectMarketing Graphs Ulilities Add-ons Window Help

SHE Me~ Bf B B B 309

Visible: 4 of 4 Variables

Preference Age Incame Gender var var var var var var var var var var var
1 1 46 2 2 =
Z 2 2 "\;-\ Recode into Different Variables: Old and New Values @
3 4 22
4 4 18 Old Value New Value
5 2 46 @ value ® value: | ‘
6 2 38 ‘ ‘ © system-missing
7 1 47 © System-missing © Copy old value(s)
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There are several options. You can change a particular value into a new value by entering
the value to be changed into the Old Value box and the new value into the New Value box
and then clicking on Add. You will usually change one "real" value to another "real" value
.For example, change 1 thru 3 into value 1.There are also other options. You can also
change a range of values into a new value and that is what we are going to do. Click on the
fourth bubble from the top labeled "Range". Notice how this marks this choice by filling in
the bubble. Then type "1" (the youngest value in the data set) in the box to the left of
"through”, click on the box to the right of through, and type "3" in that box. Then click on
"Value" just below New Value and type "1" in that box. This will have SPSS combine all
preferences from 1 through 3 into a single category and give it the value of 1. Then click on
"Add". Now do the same thing for the other categories. Click on the box under Range and
type "4" in the box to the left of "through", click on the box to the right of through, and type
"5" in that box. Click on "Value" just below New Value and type "2" in that box and click on
Add.
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To change one of your categories, highlight that category in the 0ld?> New box and make
the changes, then click on "Change". The new category should appear in the Old?>New box.
To remove a category, highlight it and click on "Remove".

Now we want SPSS to carry out the recoding. Click on "Continue" at the bottom of the
window. This will take you back to the “Recode into Different Variables” box. Click on
"OK" and SPSS will take a few seconds to carry out your commands. The data matrix should
appear on the screen. When it says that the SPSS Processor is Ready at the bottom of the

window you know that SPSS has finished with the recoding.
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Click on "Analyze", then point your mouse at "Descriptive Statistics", and then click on

"Frequencies". Notice that Preferncel has appeared in the list of variables on the left.

skokskskokokok ok ok sk sk sk sk ok ok ok ok sk sk skokok sk sk ok ok sk sk skoskok sk sk ok
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Chapter 3
T-TEST

BASIC ASSUMPTIONS FOR ALL T TESTS:
1. Scale of measurement-interval or ratio scale.
2. Random Sampling-data should be randomly sampled.

3. Population normality-data is numerical data representing samples from normally
distributed populations.

WORKING EXAMPLE:

Bharat Petroleum stocks has two kinds of petrol. * Normal Petrol’ and ‘Speed Petrol’. 30
two wheelers were tested with Normal Petrol and with Speed Petrol. The two wheelers were
having either ‘Self-start’ or ‘Kick-start’.

Two wheeler coding:1(Manual), 2(Automatic)

The earlier trail shows that mean number of Kilometer per litre was 14.

Questions:
1. Whether second trail efficiency of two wheeler is better than the previous trail?
2. Whether efficiency of engine improves with ‘Speed Petrol’?

3. Whether efficiency of engine with speed petrol and normal petrol differs between self
start and kick start?

T Test using SPSS.
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Enter the data as shown in the table below.

Two-wheeler Speed- Normal-
Type petrol Petrol
2 17 17
2 18 17
1 22 21
1 24 20
2 20 17
1 22 20
2 12 13
1 21 22
2 11 10.5
2 10 12
2 20 15
1 15 14
1 22 17
2 18 19
1 21 19
2 16 21
1 20 18
1 25 17
2 16 16
1 18 19
2 26 18
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1 28 16
2 26 21
2 22 19
2 23 20
1 18 17
1 19 15
2 17 18
2 18 21
1 16 20
1 19 16
1 10 19
1 17 18
2 18 15
2 22 20
1 23 18
2 22 19
2 18 17
2 17 16
1 26 15

» T TEST WITH ONE SAMPLE

This test is used when data from a single sample is there and when you want to know
whether the mean of population from which sample is drawn is same as the hypothesised
mean.

Click Analyze-> Compare Means->One sample T test......This will open One Sample T
Test dialogue box.

Select the test variable and click Right Arrow button to shift the variable in Test Variable
list. Change the Test Value to 14, as in the working example it is 12. Click OK to see the
Output Viewer.
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The above table shows the mean and standard deviation values of one sample t test along
with standard error mean.

One-Sample Test

Test Value = 14
t df Sig. (2- Mean 95% Confidence Interval of
tailed) Difference the Difference
Lower Upper
SPEEDPETROL 6.756 29 .000 5.36667 3.7420 6.9913

The value of two tail significance is less than 0.05(p<0.05), as such the difference between
means is significant. The output data indicates that there is a significant difference in
engine efficiency between the previous and current trail. The two wheeler in the current
trail have more engine efficiency than those in earlier trial with t(29)=6.756,p<0.05.

» T TEST WITH MORE THAN ONE SAMPLE:

This test is used to ask whether two sets of values are random samples from same or
different populations.

o If they are random samples from same population, then any differences across
conditions or groups can be attributed to random sampling variability.
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e [f two sets of values are random samples from different populations, then you can
attribute any difference between means across condition to the independent variable.

» REPEATED MEASURES T-TEST(DEPENDENT SAMPLES/ PAIRED T-TESTS)

This test is used when you have data from one group of participants that individual obtains
two values under different levels of the independent variable.

Additional Assumptions:

1. Normality of population difference value-the difference between the values for
each respondent should be normally distributed. The sample size is not too small

(30+).
Click Analyze - Compare Means 2> Paired Sample T Tests......This will open Paired
Sample T Test dialogue box.
File Edt View Data Transform Analyze DirectMarketing Graphs Utiiies Add-ons Window Help
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Select the paired variables according to your requirement. In this example Normal Petrol
and Speed Petrol are paired variables. Send the paired variables in the Paired Variables
list box as shown in the figure below. Click OK to see the output viewer.
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EoE

> OUT PUT
Paired Samples Statistics
Mean N Std. Deviation Std. Error Mean
SPEEDPETROL 19.3667 30 4.35085 .79435
Pair 1
NORMALPETROL 17.6500 30 2.83801 .51815

The table shows paired sample statistics of with Normal Petrol and Speed Petrol responses.

Paired Samples Correlations

N Correlation Sig.

SPEEDPETROL &
Pair 1 30 .544 .002
NORMALPETROL

The table above shows the paired sample correlations with correlation value of 0.544, p<0.05.

Paired Samples Test

Paired Differences t df Sig. (2-
Mean Std. Std. Error 95% Confidence tailed)
Deviation Mean Interval of the
Difference
Lower Upper
Pair 1 SPEEDPETROL - 1716 3.68053 .67197 | .34234| 3.09100 2.555 29 .016
NORMALPETROL 67
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The value of two tail significance is less than 0.05(p<0.05), as such the difference between
mean is significant. The output indicates there is a significant difference in the engine
efficiency between Speed Petrol and Normal Petrol trail. The two wheelers with speed
petrol have more engine efficiency than those with, Normal Petrol with t(29)=2.555,
p<0.05.

> INDEPENDENT GROUPS T-TEST

This test is appropriate when respondent in one condition are different from respondents
in other condition. This is commonly referred to as between subject design.

Additional Assumptions:

¢ Independence of Groups-respondent should appear in only one group and these
groups should be unrelated.

e Homogeneity of variance-The variance of groups should be similar.

To check normality assumption:

Click Analyze = Descriptive Statistics = Explore.....This will open Explore dialogue
box.
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Select the dependent variable and click Upper Right Arrow button to shift the variable
into Dependent List. Similarly do this for other variables(s). Now, shift the independent
variable into Factor List as shown below. Click OK to see the output viewer.
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» SPSS OUT PUT

Case Processing Summary

TWOWHEELER Cases
Valid Missing Total
N Percent N Percent N Percent
Manual 14| 100.0% 0 0.0% 14| 100.0%
SPEEDPETROL
Automatic 16| 100.0% 0 0.0% 16| 100.0%
Manual 14| 100.0% 0 0.0% 14| 100.0%
NORMALPETROL
Automatic 16| 100.0% 0 0.0% 16| 100.0%
Descriptives
TWOWHEELER Statistic | Std. Error
Mean 20.7857 93866
95% Confidence Interval ~ Lower Bound 18.7579
for Mean Upper Bound 22.8136
5% Trimmed Mean 20.7063
Median 21.0000
Variance 12.335
Manual Std. Deviation 3.51215
Minimum 15.00
Maximum 28.00
Range 13.00
SPEEDPETROL Interquartile Range 4.50
Skewness .282 .597
Kurtosis 111 1.154
Mean 18.1250| 1.18278
95% Confidence Interval ~ Lower Bound 15.6040
for Mean Upper Bound 20.6460
5% Trimmed Mean 18.1389
Automatic
Median 18.0000
Variance 22.383
Std. Deviation 4.73110
Minimum 10.00
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Maximum 26.00
Range 16.00
Interquartile Range 5.50
Skewness .010 564
Kurtosis -.349 1.091
Mean 18.2143 62175
95% Confidence Interval ~ Lower Bound 16.8711
for Mean Upper Bound 19.5575
5% Trimmed Mean 18.2381
Median 18.5000
Variance 5.412

Manual Std. Deviation 2.32639
Minimum 14.00
Maximum 22.00
Range 8.00
Interquartile Range 3.25
Skewness -216 .597
Kurtosis -709 1.154

NORMALPETROL

Mean 17.1563 .80327
95% Confidence Interval ~ Lower Bound 15.4441
for Mean Upper Bound 18.8684
5% Trimmed Mean 17.3125
Median 17.5000
Variance 10.324

Automatic  Std. Deviation 3.21309
Minimum 10.50
Maximum 21.00
Range 10.50
Interquartile Range 4.50
Skewness -.708 .564
Kurtosis -.216 1.091

» SPSS OUT PUT
SPEEDPETROL Stem-and-Leaf Plot for
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TWOWHEELER= Manual
Frequency Stem & Leaf
00 1.
500 1.56889
7.00 2.0112224
200 2.58

Stem width: 10.00
Eachleaf: 1 case(s)

SPEEDPETROL Stem-and-Leaf Plot for
TWOWHEELER= Automatic

Frequency Stem & Leaf

3.00 1.012

7.00 1. 6677888
4.00 2. 0023
2.00 2. 66

Stem width:  10.00
Eachleaf: 1 case(s)

3000

25.00

20007

SPEEDPETROL

15.00 —

1000

T
Manual

TWOWHEELER

T
Automatic
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NORMALPETROL Stem-and-Leaf Plot for
TWOWHEELER= Manual

Frequency Stem & Leaf

1.00 1.4
8.00 1. 56777899
5.00 2. 00012

Stem width:  10.00
Eachleaf: 1 case(s)

NORMALPETROL Stem-and-Leaf Plot for
TWOWHEELER= Automatic

Frequency Stem & Leaf
3.00 1.023
9.00 1.567778899
4.00 2.0111

Stem width:  10.00
Eachleaf: 1 case(s)

Publication Partner:

22,00

20.009

18,00

16.00]

NORMALPETROL

1400

12.00

10.00—

T
Manual

TWOWHEELER

T
Avtomatic

The above analysis shows that normality assumption is satisfied. We can proceed further

with analysis.
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»> TO CONDUCT INDEPENDENT GROUP T-TEST:

Click Analyze > Compare Means > Independent- Sample T test

This will open Independent Samples T test dialogue box.

t-test-final-sav [DataSet1] - [BM SPSS Statistics Data, fof

File Edt View Dala Transfom Analye DirectMarkeling Graphs Uliilies Add-ons Window Help

=N O, Reports 3 (= ] (& Al
-H’— Descriptive Stafistics 3 e d
Tables » |visible: 3 of 3 Variables
| TWOWHEELER | SP{  cCompare Means * [ weans T | va_ | v |
1 200 General LinearWodel | [ one-gample TTest
2 200
Generalized LNEAr OGS 1 | o g0y samples T Test
3 1.00 Mixed Models »
7 100 [ paired-Samples T Test
Correlate 4 [ e—
A One-Way
s 200 Regression > e
g 1.00 Loglinear >
I 200 Neural Networks >
8 1.00
Classity >
9 200
Dimension Reduction >
10 200 =
= 200 scale >
2 0 MNonparameticTests )
= 100 Forecasting >
tn 200 Sunival >
I 100 Multple Response >
16 2.00 [ Missing Value Analysis.
17 1.00 Muttple Imputation »
18 1.00 Complex Samples »
19 200 Quality Control »
20 1.00 ROC Curve.
2z 200 B SPSS Amos...
2 1.00 w o0
2 200 26.00 21.00
e mn m 1000
Fl 0]

Variable View

[independent-Samples T Test..

idegendt
T B

|IBM SPSS Staistics Processorisready | | | | |
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12 t-test-final.sav [DateSet]] - IBM SPSS Satistics Data — [J] B

File Edit View Data Transform Analyze DirectMarketing Graphs Utiliies Add-ons Window Hel

le,%aw- L= i

‘Vism\s 3 0f 3 Variables

| TWOWHEELER || SPEEDPETROL [NORMALPETROL] var | wvar | e | v | v | v | v [ v | o [ va [ o | o |
1 200 17.00 1700
2 200 18.00 1700
3 100 2200 2100
4 100 2400 2000
5 200 20.00 17.00 | ¢3 Independent-Samples T Test =
6 1.00 200 2000
7 200 1200 1200 — Test Variable(s): m
& TwowHEELER |
8 1.00 21.00 20 | \% speevpermoL @
] 200 11.00 1050 || | # noRmaLPETROL E
10 200 10.00 1200
1 200 20.00 15.00
2 100 16.00 1400
13 100 2200 17.00 E iGroupng yare:
% 200 18.00 19.00
18 100 21.00 19.00 Define Groups
% 200 16.00 21.00 . .
17 100 20.00 18.00 e
18 1.00 25.00 17.00
19 200 16.00 16.00
2 1.00 18.00 19.00
21 200 26,00 18.00
2 100 26,00 16.00
23 200 26,00 2100
N il il a0n z
¥

[ [1BM sPss statistics Pracessor is ready | |

NETER

Select the variable and click upper right arrow button to shift the variable in Test
variable(s) list box. Similarly, do this for another variable to be tested. Now, click the
grouping variable and end it in grouping Variable list box as shown in the figure below.

12 t-test-finalsav [DataSetl] - M SPSS Statistcs Data ——- @ &8

Fle Edt Vew Dats Transform nalze DiectMarkeing Graphs Ulities Addons Window Help

SR cx BLAH S BLE 100 %

Visible: 3 of 3 Variables

‘ TWOWHEELER = SPEEDPETROL = NORMALPETROL var var var var var war var var var var var var

1 200 0 0

2 200 18.00 17.00

3 1.00 20 21.00

4 1.00 24.00 20.00

5 200 2000 17.00 | #2 Independent-Samples T Test =

§ 100 20 20 |

7 20 20 150 ol (opions_ ] | [

8 100 20 20 ﬁ:ﬁma (Eootsiep. |

3 200 10 1050 |

[0 200 1000 20 @

[0 200 20 1500

2 00 1600 w0

3 100 200 1700 - RN NaE e

" 200 800 1900 e

15 1.00 2100 19.00 Define Groups.

15 200 16.00 700 | p—

7 1m0 0 1500 oo o i)

18 1.00 2500 17.00

1 ) 600 %00

2 00 1800 1900

2 ) %0 1500

2 00 50 1600

a 200 %0 20

™ E
e —————— I

1B SPSS Stafistics Processoris ready
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Click define group button below Grouping Variable. This will open Define Groups sub
dialog box. Enter the values as desired for analysis. In this case enter values as shown and

click OK.

8t st S S ™ Beaese 2 SLIES
File Edit View Data Transform Analze DifectMarketing Graphs Utiities Add-ons Window Help

SHE M e~ Bl i &K BLE 190 %

Visible: 3 of 3 Variables

TWOWHEELER | SPEEDPETROL | NORMALPETROL | var var var var var var var var var var var var
1 2.00 17.00 17.00 =
2 200 18.00 17.00
3 1.00 2200 2100
4 1.00 2400 2000
5 2.00 20.00 17.00 [ #3 Independent-Samples T Test n
6 1.00 2200 2000
7 200 1200 13.00 1R Defne Grows )
8 1.00 2100 22.00
9 2.00 11.00 10.50 ® Use specified values
10 2.00 10.00 12.00 Group 1
1" 200 2000 15.00 Group 2
12 1.00 15.00 14.00
© Cut point:
13 1.00 2200 17.00 =
14 2.00 18.00 19.00
1 1.00 21.00 12.00
16 200 16.00 2100 ok T Eore \Eemet) | Cancal ok
17 1.00 2000 18.00
18 1.00 26.00 17.00
19 200 16.00 16.00
20 1.00 18.00 12.00
21 200 26.00 18.00
2 1.00 28.00 16.00
2 200 26.00 2100
w m n 100 i ‘E
Data View Variable View
IBM SPSS Statistics Processor is ready
= 5

» OUT PUT

Group Statistics

TWOWHEELER N Mean Std. Deviation Std. Error Mean

Manual 14 20.7857 3.51215 .93866
SPEEDPETROL

Automatic 16 18.1250 4.73110 1.18278

Manual 14 18.2143 2.32639 62175
NORMALPETROL

Automatic 16 17.1563 3.21309 .80327

Independent Samples Test

Levene's t-test for Equality of Means
Test for
Equality of
Variances
F Sig. t df Sig. (2- Mean Std. Error 95% Confidence
tailed) | Difference | Difference Interval of the
Difference
Lower Upper
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Equal
variances 783 | .384| 1.727 28 .095 2.66071 1.54044 | -49474

assumed
SPEEDPETROL
Equal

variances not 1.762| 27.334 .089 2.66071 1.50998 | -.43574
assumed
Equal

variances 807 | .377| 1.019 28 317 1.05804 1.03791
1.06802
assumed

NORMALPETROL
Equal

variances not 1.042 | 27.124 307 1.05804 1.01579
1.02574

assumed

5.81617

5.75717

3.18409

3.14181

The Levene’s test in Speed Petrol shows probability greater than 0.05, that is 0.383, which
says that population variance is relatively equal. The two tail significance for speed petrol
shows that p>0.05 and therefore is not significant. We can say that two groups come from
same population since no significant difference exist —-t(28)=1.727,p>0.05. This can also
said as Null Hypothesis. No Significant difference exist in two wheelers types in case of
speed petrol.

The Levene’s test in Normal Petrol shows probability greater than 0.05, that is 0.377,
which says that population variance are relatively equal. The two tail significance for
speed petrol shows that p>0.05 and therefore is not significant. We can say that two
groups come from same population since no significant difference exist -
t(28)=1.019,p>0.05. This can also said as Null Hypothesis. No Significant difference exist
in two wheelers types in case of Normal petrol.

» EXERCISE:

‘Talent Hunt’ Soft skill training institute has conducted QUIZ1 and QUIZ2 on General
awareness. In total 25 students appeared for the same.

Student -GENDER coding:1(MALE), 2(FEMALE)
The earlier mean was 36.
Questions:

1. Whether Quiz 2 was better than QUIZ 1.
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2. Whether the score has improved in QUIZ2?

3. Whether there is difference in score between MALE & FEMALE Gender.

GENDE [1|1(1|2(2|1(2|1|2|2|1|1(2|1|2|2|2|2|2|1|1|2|1|2]|2
R

QUIZ1

QUIZ2

Bowor
= ooy B
[ool N I° O]
w oo
= oy w
O W W
N W (W s
e NG
g A |w o
NSO W
W W W
N NN w
= ooy W
0 W(N W
[SaRNY PN N
O B (N
O B s
N W[y W
O N[~ W
Ul WO w
0 W~
N (o s
= o [00 W
B w|w w
=N W
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Chapter 5
Correlation and Regression Analysis

Correlation coefficient summarizes and quantifies the relationship between two variables
in a single number and it is denoted by small letter ‘r’. This number range from -1 to +1.-1
represents a perfect negative or inverse relationship to 0 representing no relationship or
complete independence to +1 representing a perfect positive or direct relationship. When
we calculate a coefficient correlation fro sample data, we need to see whether it is having
positive, negative and no relation. Scatter plot helps to examine the nature of relationship.
Sometimes correlation is low not because of a lack of relationship but because of a lack of
linear relationship. In such case, examining the scatter plot will assist in finding whether
the relationship may be non linear.

Steps for calculating correlation:

Analyze-> correlate-> Bivariate.....
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8 Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor = &5
File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Window Help
B [ . Reports 3 :@ = e :E ;AJ.’ f ARG
ﬁ M . Descriptive Stafistics » ﬁ . R A | ad 9 9 =
Tables b Visible: 0 of 0 Variables
ar var Compare Means 3 ar var ar ar ar ar ar ar var ar var var
1 General Linear Model 3 —r
2 Generalized Linear Models »
3 Wixed Models »
-f Correlate b | [ Bivariate
; ?egressmn ¢ EPa[tial.
7 L1 2 b [ Distances
Neural Networks 3
§ Classify 3
190 Dimension Reduction 3
1 Scale »
2 Monparametric Tests 3 |
13 Forecasting 3
14 Survival 3
15 Multiple Response 3
16 Missing Value Analysis.
17 Multiple Imputation ¢
18 Complex Samples 3
19 Quality Control 3
20 [ Roc curve..
2 IBM SPSS Amos..
2
23 ||
24 Z \’\:
Data View || Variable View
Caorrelate IBM SPSS Statistics Processor is ready
j=Jo0 e ¢ 5 8 s alc]a]lE] SOOI

» WORKING EXAMPLE:

Table shows the data of sales department. Distribution cost is given in thousands. Check
whether any correlation exist between distribution cost, order placed and actual sales.

Sr.No. Distribution Cost Orders placed | Actual Sales
1. 52.95 4015 386
2. 71.66 3802 446
3. 85.58 5309 512
4. 63.69 4262 401
5. 72.81 4296 457
6. 68.44 4097 458
7. 52.46 3213 301
8. 70.27 4809 484
9. 82.03 5237 517
10. 74.39 4732 503
11. 70.84 4413 535
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1
12
13
14
15
16
17
18
19
20
pal
2
23
24
25

12. 54.08 2921 353
13. 62.98 3977 372
14. 72.3 4428 372
15. 58.99 3964 408
16. 79.38 4582 491
17. 94.44 5582 527
18. 59.744 3450 444
19. 90.5 5079 623
20. 93.24 5735 596
21. 69.33 4269 463
22. 53.71 3708 389
23. 89.18 5387 547
24. 66.8 4161 415
Create a SPSS file for the above data.
1 "Uniitcd? [DataSetl] - oM 5755 Statisics Do il W
SHEDN e~ BB i By BOF 10® %
Name Type Width | Decimals Label Values Missing Columns Align Measure Rale

1 DistCast Numeric 10 2 Dist Cost None None 1" = Right & Scale “ Input

2 Order Numeric 10 0 order placed None None 1" = Right & Scale “ Input

3 ActualSales  Numeric 10 0 Actual Sales None None 1" = Right & Scale “ Input

4

:

i

1 1

£l

Data View | Variable View
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2 Ut sy s S s -

Fle EGt View Dala Translom Analge DirectMarkeling Graphs Uliiies Addons Window Help

SHEDNe~BLIHEIELE {00 %
|

Visible: 3 of 3 Variables

I DistCost | Order ActualSales var | ar var var var | var var var war var var var W

1 5295 4015 386
2 7166 3802 46
3 8558 5309 512
4 6369 4762 40
5 7281 4756 457
6 6844 4097 458
7 5246 13 n

T 4809 44

8203 27 517

743 4732 503

\ _ 1B SPSS Statistics Processoris ready |

L] 806 PM

5 “Untited2 [DataSett) - W PSS Sakicis Oota | O
File Edit View Dalta Transrm anahze DirectMarkeling Graphs Uliilies Add-ons Window Help

= Reorts S EE A=Y )
SHE M| . )58 EAE . 5|
Tagles v Visible: 3 of 3 Variables
DistCost Gompars Maans vl [ ar ar var var v - - o o - v
d 5285 | CeneralLincarModel ¢ =]
z B | GensraigsaLnessMacess ¢
1 8558 | - ~
4 6369
5 7281 i::!a:m : Bevate
& 20 Logiinear o[
7 5246 . I pistances
8 T027 o
classty »
e 20 Dimension Reducton  +
10 ] -
" 708 Sce "
o e | MowpmencTems
—n S — '
" 7230 | I el 4
% 5999 | Musple Response »
16 7938 | Bl missing Value Analysis.
7 M | Mumple mputation v
W 974 | comptex Sampies v
18 90 50 | Gualty Conol v
2 [EEN | Edroccune
il 6833 1B SRS Amos...
2 5371
a ) 5391 1 Ll
-.—————————— —

B

Open the Bivariate Correlations dialogue box . following dialogue box will open.
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"n_',-\ Bivariate Correlations @
Variables:
& Dist Cost [DistCost]
& order placed [Order] Bootstrap...

&7 Actual Sales [Actual...

Correlation Coefficients

[+ Pearson [| Kendall's tau-b [_] Spearman

Test of Significance

@ Two-tailed © One-tailed

[+l Flag significant correlations

:] | Reset || cancel | | Heip |

Select the variables and send it in variables list box by clicking right arrow button. Click
Pearson check box and Flag significant correlations check box as shown in the figure
below. See the test of significance is set according to the requirement. In our case it is two

tailed.
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- B
ﬁ Bivariate Correlations ﬂ

Variables:
& Dist Cost [DistCost]
g& order placed [Order] [M—W]

& Actual Sales [Actual... |

~ Correlation Coefficients
[ Pearson [ Kendall's tau-b [~] Spearman

- Test of Significance
@ Two-tailed © One-tailed

[+ Flag significant correlations

[ oKk || Paste || Reset |[cancel|| Help |

Click Options...button to open its sub dialogue box. Select the Statistics and Missing
values option . Click Continue to close the sub dialogue box. The previous dialogue box
will appear again. Click OK to get the output.

- e
Q Bivariate Correlations: Options M

—Statistics

[+ Means and standard deviations

[¥iCross-product deviations and covariances

~Missing Values

@ Exclude cases pairwise
| Exclude cases listwise

| | continue || Cancel || Help |

-
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Descriptive Statistics

Mean Std. Deviation N
Dist Cost 71.2414 12.93087 24
order placed 4392.83 737.220 24
Actual Sales 458.33 78.971 24
Correlations
Dist Cost order placed Actual Sales
Pearson Correlation 1 918" 871"
Sig. (2-tailed) .000 .000
Sum of Squares and Cross-
Dist Cost 3845.770 201185.604 20451.133
products
Covariance 167.207 8747.200 889.180
N 24 24 24
Pearson Correlation 918 1 827"
Sig. (2-tailed) .000 .000
order placed Sum of Squares and Cross- 201185.604 12500337.333 1107733.333
products
Covariance 8747.200 543492.928 48162.319
N 24 24 24
Pearson Correlation 871" 827 1
Sig. (2-tailed) .000 .000
Actual Sales Sum of Squares and Cross- 20451.133 1107733.333 143439.333
products
Covariance 889.180 48162.319 6236.493
N 24 24 24

The bivariate correlation is undertaken between the respondents. it was hypothesized that
a relationship exists between Distribution cost and order placed, distribution cost and
actual sales. The above result shows that there exist the correlation. Distribution cost and
Orders placed the correlation ratio ‘ r’ is 0.918, which shows that both are highly
correlated. Distribution cost and Actual Sales correlation ratio ‘ r’ is 0.871, which shows

**_ Correlation is significant at the 0.01 level (2-tailed).

that both are highly correlated. And p< 0.05 in both the cases.
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» CONSTRUCTING A SCATTER PLOT

Select Graph—-> Legacy Dialogs—> Scatter/Dot....This will open Scatter/Dot dialogue box

e A—— -

Graphs  Utilities Add-ons  Window Help

fild Chart Builder.. E l__]ﬁll \_0 \bJ‘ A
1 E L

Graphboard Template Chooser.
ﬂar.

[l 3-0 Bar

E\:me..

Bgrea .

Erie
ﬂlgh-\_uw..

E Boxplot

E Errar Bar...

[ Population Pyramid
[ ScatterDot

E Histagram

~

Legacy Dialogs
7T 7T 7T

@ @

Click Simple Scatter button and click Define to open Simple Scatter plot dialogue box.

"\_',J Scatter/Dot @
‘ Simple Matrix Simple
it ol Scatter |2 | Scatter Dot

;| 3D
<: | Scatter

' Overlay
LT A
ﬁ"" *| Scatter

[ Define ] [Cancel ] [ Help ]

Select the variables of X axis and Y axis .
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- PSR B —
Simple Scatterplot - E

¥ Axis:
& Actual Sales [Actual... | & Dist Cost DistCost |

X Avis:

| & orcer placed [Orden] |
Set Markers by:
Label Cases by.

rPanel by
Rows:
»
Columns
»
Template
[T] Use chart specifications from:
File...

[ ok |[ Paste |[ Reset |[cancel |[ Help

Click Options...button to open Options sub dialogue box. Select the options accordingly.
Click continue to get the output.

| - - ™
@ Options — u

Missing Values

@ Exclude cases listwise

@ Exclude cases variable Y varlaole

[] Display groups defined by missing values
EcC
B Display error bars

rError Bars Represent

@ Confidence intervals

t [Conlinue” Cancel ” Help ]
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Dist Cost

> REGRESSION

Distribution Cost Vs. Order Placed

100.00-

90,00

80.00-

70.00

60.00

50,00

T
2000

T T
3000 4000

order placed

T
5000

T
6000

In Linear regression, we are finding the equation of a straight line that best fits the
observation. We can use the line to predict a value of Y for any value of X. This line will
have an intercept term and a slope coefficient and is represented as:

Y=a+bX

Lets use the same example for regression also.

Click Analyze—> Regression—>Linear..... this will open Linear Regression Dialouge box.
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Analyze Direct Marketing Graphs Utilities Add-ons  Window Help

Reports 2 Aty
Dgil:ﬂpl\ve Statistics » i ﬁ E % u'lé ﬂ
Tables »
Compare Means » par var var va
General Linear Model 2
Generalized Linear Models
Mixed Models 2
Correlate »
Regression | [ Automatic Linear Modeling
Loglinear 3 E\:mear )
ISHSI e tw or ' [&] curve Estimation.
Classily ' Partial Least Squares.
Dimension Reduction 2
-~ N [ Binary Logistic.
Nonparametric Tests » Emumnomlal Logistic...
Forecasting 3 Ordinal
Surval v | Bl provit
Multiple Response » ﬂnnlmear

Missing Value Analysis.. [Fd weight Estimation...
Multiple Imputation ¢ g—Slage Least Squares.
Complex Samples L Optimal Scaling (CATREG)
Quality Control 3

ROC Cune...
IBM 5PSS Amos

Select the dependent variable as ‘Distribution cost’ and send it to Dependent list box. Select
‘orders placed’ as independent variable and send it to independent variable.

r@ Linear Regression @1
Dependent: e
| -_

& order placed [Order] % | [ DistCost DistCost]
& Actual Sales [Actual.. | g0 o 4 of 4

Independent(s):

tiol
& order placed [Order] Bootstrap

Selection Variable:

Case Labels:

WLS Weight:

[ OK ][ Paste ][ Reset ][Cancel][ Help ]

Click Statistics...button to open its sub dialogue box. Select the required statistics as
shown in the figure below. Click Continue to close sub dialogue box. Previous dialogue
box will reappear.
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@ Linear Regression: Statistics. I&
Regression Coefficients | [/ Model fit
@gsnmateg ["] R squared change
[] Confidence intervals | [] Descriptives

|| Part and partial correlations
7] Covariance matrix [C] Collinearity diagnostics
Residuals
[7] Durbin-Watson

[T] Casewise diagnostics
@

[continue ] [ cancel [ Hep |

Click plots...to open Plots sub dialogue box. Select the plots as required by you. Click
continue to close the sub dialouge box. Previous dialogue box will reappear.

EP Linear Regression: Plots Iﬂ

DEPENDNT Scatter 1 of 1
*ZPRED
*ZRESID
*DRESID

Y:
*SRESID
X
*SDRESID =
——

| Produce all partial plots

Standardized Residual Plots

|| Histagram

| Mormal probability plot

[continue ] [ cancel ][ Heip |

#3 Linear Regression: Plots @

DEPEMDNT Scatter 1 of 1
*ZPRED
*ZRESID L5
*DRESID

¥:
*ADJPRED DEPENDNT
*SRESID
X
*ZPRED

*SDRESID
[] Produce all partial plots

Standardized Residual Plots

|+ Histogram

[Conﬁnue][ Cancel ][ Help ]

Click Options....to open Options sub dialogue box. Select the options as required by you.
Click Continue to close the sub dialogue box. Previous dialogue box will reappear. Click
OK to get the ouptput.
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'{r\ Linear Regression: Options li_E-J

Stepping Method Criteria

Entry: Removal:

© Use Fvalue

[ Include constant in equation
Missing Values
@ Exclude cases listwise
©) Exclude cases pairwise

© Replace with mean

[Cuntinue][ Cancel ][ Help ]

Variables Entered /Removed?

Model Variables Variables Method
Entered Removed
1 order placedb .| Enter

a. Dependent Variable: Dist Cost

b. All requested variables entered.

The table above shows the variable entered or removed in the model.

Model Summary®

Model R R Square Adjusted R Std. Error of the
Square Estimate
1 .918a 842 .835 5.25619

a. Predictors: (Constant), order placed

b. Dependent Variable: Dist Cost

The table above shows the model summary.

ANOVA2
Model Sum of Squares df Mean Square F Sig.
Regression 3237.964 1 3237.964 117.201 .000p
1 Residual 607.806 22 27.628
Total 3845.770 23

a. Dependent Variable: Dist Cost
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b. Predictors: (Constant), order placed

The table above shows the ANOVA values with sum of squares, degree of freedom, mean

square, F statistic and level of significance.

Coefficients2
Model Unstandardized Coefficients Standardized t Sig.
Coefficients
B Std. Error Beta
(Constant) 541 6.618 .082 936
! order placed .016 .001 918 10.826 .000
a. Dependent Variable: Dist Cost
Residuals Statistics2
Minimum Maximum Mean Std. Deviation N
Predicted Value 47.5531 92.8428 71.2414 11.86512 24
Residual -12.21041 9.92770 .00000 5.14066 24
Std. Predicted Value -1.996 1.821 .000 1.000 24
Std. Residual -2.323 1.889 .000 978 24
a. Dependent Variable: Dist Cost

The table above shows the residual statistics with predicted value, residual, standard

predicted values and standard residual values.

Histogram

Dependent Variable: Dist Cost

Frequency

/-

/T

\

=24

-2 El

o

Regression Standardized Residual

Mean = -2.11E-16
Std.Dev. = 0978

The figure above shows the Histogram of dependent variable, Distribution cost.
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MNormal P-P Plot of Regression Standardized Residual

Dependent Variable: Dist Cost

1.0

Expected Cum Prob
o

0.0 T T T
00 02 04 08 08 1.0

Observed Cum Prob
The figure above values shows the Normal P-P plot of Regression Standard Residual values.
The above all steps can be repeated, by taking ‘Distribution cost ‘ as dependent variable
and ‘Actual Sales’ as the other independent variable.

» MULTIPLE REGRESSION MODEL
Multiple regression involves one dependent variable and two or more independent
variables. The multiple regression equation is represented as:

Y=bo+b1X1+b2X2+..ceveen. +bn Xn

Lets use the same example for regression also.

Click Analyze—> Regression—>Linear..... this will open Linear Regression Dialouge box.
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Analyze  Direct Marketing

Reports
Descriptive Statistics
Tables
Compare Means
General Linear Model
Generalized Linear Models
Mixed Models
Correlate
Regression
Loglinear
Neural Networks
Classify
Dimension Reduction
Scale
Monparametric Tests
Forecasting
Survival
Multiple Response

Missing Value Analysis...
Multiple Imputation
Complex Samples
Quality Control

ROC Curve...
IBM SPSS Amos...

Graphs Utilities Add-ons Window Help
EN-EY
2
» par var var va
3
»

3
»

’ E Automatic Linear Modeling..

b Linear...

% Curve Estimation...

' Partial Least Squares...
: [i] Binary Logistic...

R [ Multinomial Logistic...

5 Ordinal...

v | B Probit..

» | [ Monlinear...

[d] weight Estimation...

2 E 2-Stage Least Squares...

s Optimal Scaling (CATREG)...

T Rk

@ Linear Regression

Dependent:
& order placed [Order] % [ DistCost DistCost] |
& Actual Sales [Actual... | g q o

Independentis):

& order placed [Order]
& Actual Sales [AclualSales]

Selection Variable

Case Labels:

WLS Weight:

(Lox_J (gaste ) (Resst) (cancer) (e )

Take ‘Distribution cost’ as dependent variable and ‘orders placed’ and ‘Actual sales’ as two

independent variables.

Click statistics button and check in front of collinearity diagnostics.
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@ Linear Regression: Statistics R
Regression Coefficients| [ Model fit
[/ Estimates [7] R squared change
[C] Confidence intervals | [] Descriptives

[] Part and partial correlations

[T] Covariance matrix ]
Residuals

[] Durbin-Watson
[] Casewise diagnostics
Q

[Continue][ Cancel ][ Help ]

Select Continue and then click on Plots to request standardized residual plots and also to request
scatter diagrams. Select histogram and normal distribution plot of the standardized residuals.

Variables Entered /Removed2

Model Variables Variables Method

Entered Removed

Actual Sales,
1 . | Enter

order placedb

a. Dependent Variable: Dist Cost

b. All requested variables entered.

Model Summary

Model R R Square Adjusted R Std. Error of the
Square Estimate
1 9392 .881 .870 4.65918

a. Predictors: (Constant), Actual Sales, order placed

Value of R2is 0.881 and it indicates 88.1 % of variation.

ANOVAa
Model Sum of Squares df Mean Square F Sig.
Regression 3389.902 2 1694.951 78.080 .000v
1 Residual 455.868 21 21.708
Total 3845.770 23

a. Dependent Variable: Dist Cost

b. Predictors: (Constant), Actual Sales, order placed
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Coefficientsa
Model Unstandardized Coefficients Standardized t Sig.
Coefficients
B Std. Error Beta
(Constant) -3.459 6.058 -571 574
1 order placed 011 .002 625 4.673 .000
Actual Sales .058 .022 354 2.646 .015
a. Dependent Variable: Dist Cost
Collinearity Diagnostics2
Model  Dimension Eigenvalue | Condition Index Variance Proportions
(Constant) order placed Actual Sales
1 2.979 1.000 .00 .00 .00
1 2 .017 13.413 .99 .07 .10
3 .005 25.302 .00 .93 .90

a. Dependent Variable: Dist Cost

The collinearity diagnostics indicate a low degree of overlap between the predictors. If two
predictor variables were orthogonal (uncorrelated), the variance inflation factor for each

would be 1. Thus we can say that there is no problem of collinearity in this case.

Residuals Statistics?

Minimum | Maximum Mean Std. Deviation N
Predicted Value 49.0069 93.9277 71.2414 12.14031 24
Residual -9.95979 7.60913 .00000 4.45200 24
Std. Predicted Value -1.831 1.869 .000 1.000 24
Std. Residual -2.138 1.633 .000 956 24

a. Dependent Variable: Dist Cost
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Histogram
Dependent Variable: Dist Cost

Frequency
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Regression Standardized Residual

The histogram of the standardized residual shows that the departure from normality is not

too severe.

Normal P-P Plot of Regression Standardized Residual

Dependent Variable: Dist Cost
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The normal P-P plot indicates some

T
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T
08 08 1.0

Observed Cum Prob

departure from normality and may suggest a

curvilinear relationship between the predictors and the criterion.
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Scatterplot

Dependent Variable: Dist Cost

Regression Standardized Predicted Value
i

-2

Regression Standardized Residual

The plot of the standardized predicted values against the standardized residuals indicates a

large degree of heteroscedasticity.
» WORKING EXAMPLE:

A survey is conducted in order to find the preference criteria of a popular brand of ice

cream. Responses were collected in 7 point Likert scale. Preferences were measured with

respect to its nutrition value, flavor and presentation.

preference Nutrition value flavour | presentation
7 5 6 5
6 4 6 6
5 5 7 4
6 6 7 5
4 3 2 4
2 2 1 2
3 3 2 3
6 5 6 5
7 7 7 6
5 6 5 4
4 4 3 2
3 6 2 3
1 1 2 1
2 2 3 1
4 5 4 3
4 4 5 4
3 2 1 3
6 7 5 4
6 5 5 6
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7 6 4 5
7 5 6 6
3 2 3 4
2 2 1 1
5 5 4 4
6 5 6 4
7 6 5 7
2 1 1 2
4 2 1 2
6 4 5 5
7 6 5 5
6 3 6 5
5 4 4 4
2 1 1 2
3 2 1 1
4 3 2 2
6 5 7 6
7 6 7 6
7 5 6 7
4 3 2 3
5 3 4 3

Find whether there is any relation between preferences and its nutrition value, flavor and
presentation. Perform Single regression and multiple regression analysis and interpret
your answers.
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Chapter 6
ANOVA

ANOVA is used when you want to compare means of more than two groups or level of an
independent variable. ANOVA test comes under parametric and it satisfies the following
assumptions.

e Data is numerical data representing normally distributed populations.
e The variance of groups are similar.

e Sizes of group are similar.

e The groups should be independent.

ANOVA tests the null hypothesis that means of all the groups being compared are equal and
produces a statistics called F. if the mean of all the groups tested by ANOVA are equal, then null
hypothesis is proved. In case of the rejection of null hypothesis , we perform Brown-Forsythe and
Welch test in SPSS.

Homogeneity of variance :If significance value is less than 0.05, variances of groups are
significantly different.

Brown-Forsythe and Welch test : :If significance value is less than 0.05, reject null hypothesis.
ANOVA: :If significance value is less than 0.05, reject null hypothesis.

Post-Hoc analysis are used to protect against type [ errors, given that all the possible comparisons
are going to be made. Some of the Post-Hoc tests are:

o Scheffe test-allows every possible comparison to be made but is tough on rejecting the null
hypothesis.

o Tukey test/honestly significant difference(HSD) test-lenient but the types of comparison
that can be made are restricted.

» One Way ANOVA:
WORKING EXAMPLE:

Excellence coaching centre want to compare the competitive exam score of its registered
students from 5 different centers namely, Ramnagar, Gandhinagar, SBI square, Azad Nagar
and Civil Lines . 10 score based on random sampling from each centre has been taken as
sample for study. Note that the sample is independent sample as they belong to the
different study centre.
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Alternate Hypothesis:There is significant difference in scores from the different study centers.

Sr.No.

Sr.no. City Score
1. 1 400
2. 1 450
3. 1 499
4. 1 480
5. 1 495
6. 1 300
7. 1 350
8. 1 356
9. 1 269
10. 1 298
11. 2 389
12. 2 398
13. 2 399
14. 2 599
15. 2 598
16. 2 457
17. 2 498
18. 2 400
19. 2 300
20. 2 369
21. 3 488
22. 3 469

City Score
26. 3 385
27. 3 358
28. 3 299
29. 3 298
30. 3 389
31. 4 450
32. 4 400
33. 4 450
34, 4 428
35. 4 398
36. 4 359
37. 4 360
38. 4 302
39. 4 310
40. 4 295
41. 5 299
42. 5 599
43. 5 466
44, 5 591
45. 5 502
46. 5 598
47. 5 548
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23. 3 425 48, 5 459
24. 3 450 49, 5 489
25. 3 399 50. 5 499

SEe M~ BHE 0B

Role
“w Input
N Input

Measure ||
& Nominal
& Scale

Missing || Columns H Align H
Mone 11 Right
Mone 11 Right

Values ||
None

Type H Width || Decimals H Label ||
Numeric 11

I Name H
City
Score

Numeric 11 0 Score None

= B S e S S

12 ANGVA-SHINY-BODK.sav [DataSetT] - IBM SPS Data Editor oo S

Fie Edt View Data Transfom Analze DirectMarketng Graphs Utilties Add-ons Window Help

\Visile: 2012 Varables

[ oy | e [ v | w [ a [ e | w [ v [ v [ w | w | [ w [ va | a |
1 1 300
2 1 350
3 1 399
4 1 380
5 1 395
) 1 200
1 1 240
8 1 256
9 1 169
10 1 198
i 2 198
12 2 199
13 2 499
1 2 366
18 2 M
16 2 402
17 2 498
18 2 48
19 2 359
2 2 399
Al 3 269
2 3 298
A 3 499 L
E7 Il v
1 ]
=
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PLTT e am |

Analyze  Direct Marketing

Graphs

Utilities  Add-ons

Window  Help

Reports
Descriptive Statistics
Tables
Compare Means
General Linear Mode!
Generalized Linear Models
Mixed Models
Correlate
Regression
Loglinear
Neural Networks
Classify
Dimension Reduction
Scale
Nonparametric Tests
Farecasting
Survival
Multiple Respanse

Missing Value Analysis...
Multiple Imputation
Complex Samples
Quality Control

ROC Curve
IBM SPSS Amos

S

,
,
v
,
,
,
,
N
N
N
N
N
N
5
,
,
,

2] Means

[A one-way ANOVA ..

E One-Sample T Test..
[F1 Independent-Samples T Test
E Paired-Samples T Test...

2 One-Way ANOVA

@ City |

@9 Score [Score]

Dependent List:

m |Eactor:

E] Paste [Reset”Cancel” Help]

E
i

PostHoc...

Qptions...

=
II
=]

Transfer ‘ Score’ to dependent list and ‘City’ to Factor.
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"
E2 One-Way ANOVA

I

Dependent List
f Score [Score]

PostHoc...

Options...

HI
=

Fr—

[ ok |[ Paste |[ Reset |[cancel|[ Help |

Click contrasts.....push button. Contrasts sub dialogue box will open. See all the settings remain as
shown in the figure below. Click continue to close and come back to One-Way ANOVA dialogue box.

Q Cne-Way ANOVA: Contrasts ﬁ1

|

I Coefficient Total: 0.000 I
[continue|[ cancel |[ Hep |

Click Post-Hoc. Click Tukey test and click continue. Come back to One-way ANOVA
dialogue box. Also note significant level in this sub dialogue box is 0.05, which can be
changed according to the need.

7~ ™Y
Q One-Way ANOWVA: Post Hoc Multiple Comparisons ﬂ

rEqual Variances Assumed

[ LsD [C] 5-N-K [] waller-Duncan

[T] Bonferroni [+ ].a Type IType Il Error Ratic

[T] sidak [T] Tukeys-b [] Dunnett

[T] Scheffe [] Duncan Control Category © |Last -

[ RE-G-WQ [[] Gabrigl @ 2-sided @ = Control @ = Contro

[ R-E-G-WF [7] Hochberg's GT2 "Te t

rEqual Variances Mot Assumed

[7] Tamhane's T2 [| Dunnetts T3  [| Games-Howell [ Dunnetts C

[continue | [ cancel |[ Hep |

R o e
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Click options. Select Descriptive and Homogeneity of variance test and see all the settings remain

as shown in the figure below. Click continue to close this sub dialogue box and come back to One
way ANOVA dialogue box. Click OK to see the output.

't,-‘ One-Way ANOVA: Options

=

Statistics

[+ Descriptive

[7] Fixed and random effects

[ Eﬂomogeneiw of variance tesf

] Welch

[] Means plot

Missing Values

[C] Brown-Forsythe

@ Exclude cases analysis by analysis

@ Exclude cases listwise

[Continue][ Cancel ][ Help ]

OUTPUT:
Descriptives
Score
N Mean Std. Deviation Std. Error 95% Confidence Interval for Mean Minimum Maximum
Lower Bound Upper Bound
1 10 389.70 87.347 27.622 327.22 452.18 269 499
2 10 440.70 97.855 30.944 370.70 510.70 300 599
3 10 396.00 65.137 20.598 349.40 442.60 298 488
4 10 375.20 59.299 18.752 332.78 417.62 295 450
5 10 505.00 90.126 28.500 440.53 569.47 299 599
Total 50 421.32 91.389 12.924 395.35 447.29 269 599

Score

Test of Homogeneity of Variances

Levene Statistic

dfl

df2 Sig.

.868

4

45 491

Since homogeneity of variance should not be there for conducting ANOVA tests, which is

one of the assumption of ANOVA, we see that Levene’s test shows that homogeneity of

variance is not significant (p>0.05).

approximately equal.

the population variance for each group are
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ANOVA
Score
Sum of Squares df Mean Square F Sig.
Between Groups 111459.080 4 27864.770 4.211 .006
Within Groups 297783.800 45 6617.418
Total 409242.880 49

Table shows the F test value along with the degrees of freedom and significance is 0.006,

you can reject the null hypothesis and accept the alternate hypothesis. That is there is

significant difference in scores from the different study centers. F=4.211 ,p < 0.05.

Dependent Variable: Score

Multiple Comparisons

Tukey HSD
(D City () City Mean Difference Std. Sig. 95% Confidence Interval
(I-N Error Lower Bound Upper Bound
Gandhinagar -51.000 | 36.380| .630 -154.37 52.37
SBI square -6.300 | 36.380| 1.000 -109.67 97.07
Ramnagar
Azad Nagar 14.500| 36.380| .994 -88.87 117.87
Civil Lines -115.300"| 36.380| .022 -218.67 -11.93
Ramnagar 51.000| 36.380| .630 -52.37 154.37
SBI square 44.700| 36.380| .735 -58.67 148.07
Gandhinagar
Azad Nagar 65.500| 36.380| .386 -37.87 168.87
Civil Lines -64.300 | 36.380| .405 -167.67 39.07
Ramnagar 6.300| 36.380| 1.000 -97.07 109.67
Gandhinagar -44.700| 36.380| .735 -148.07 58.67
SBI square
Azad Nagar 20.800| 36.380| .979 -82.57 124.17
Civil Lines -109.000"| 36.380| .034 -212.37 -5.63
Ramnagar -14.500 | 36.380| .994 -117.87 88.87
Gandhinagar -65.500| 36.380| .386 -168.87 37.87
Azad Nagar
SBI square -20.800| 36.380| .979 -124.17 82.57
Civil Lines -129.800"| 36.380| .007 -233.17 -26.43
Ramnagar 115.300"| 36.380| .022 11.93 218.67
Civil Lines Gandhinagar 64.300| 36.380| .405 -39.07 167.67
SBI square 109.000"| 36.380| .034 5.63 212.37
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Azad Nagar 129.800"| 36.380 | .007 ‘ 2643 233.17

*. The mean difference is significant at the 0.05 level.

Using Tukey HSD further, we can conclude that Gandhinagar and Civil Lines have
significant difference in their scores. This can be concluded from figure above and figure
below.

Score
Tukey HSD
City N Subset for alpha = 0.05

1 2

Azad Nagar 10 375.20
Ramnagar 10 389.70
SBI square 10 396.00
Gandhinagar 10 440.70 440.70
Civil Lines 10 505.00
Sig. .386 405

Means for groups in homogeneous subsets are displayed.

a. Uses Harmonic Mean Sample Size = 10.000.

» TWO WAY ANOVA
Two way ANOVA is similar to one way ANOVA , except in this case additional independent
variable is introduced and each independent variable includes two or more variants.
WORKING EXAMPLE:
Pinnacle Marketing Research firm wants to conduct a study to find whether Sales of the
respondent depends upon territory and qualification. 13 sales people were considered
from each territory and each respondent can select three education levels.
Territory : Gandhinagar=1,Cosmos Town=2 and Sadar=3.
Qualification: Under graduate=1, Graduate=2 and post graduate=3.
A total of 3x3x13=117 responses were collected.
Research Questions:
Whether territory influences sales?

Education influences sales?

Sr.No. | Territory | Qualification | Sales Sr.No. | Territory | Qualification | Sales

1. 1 1 20 21. 3 3 75

Monograph on ‘ SPSS Basics - Handbook’- by .Shiney Chib, shinychib@gmail.com Page 91



Publication Partner:

International Journal of Scientific and Research Publications (ISSN: 2250-3153)

2. 1 3 50 22. 3 2 30
3. 1 2 45 23. 3 1 35
4. 1 2 50 24. 3 2 43
5. 1 3 64 25, 3 2 40
6. 1 1 35 26. 3 2 40
7. 1 3 54 27. 3 3 55
8. 1 3 60 28. 3 2 30
9. 1 3 55 29. 3 2 75
10. 1 2 35 30. 3 3 60
11. 2 3 65 31. 2 3 50
12. 2 3 65 32. 2 1 20
13. 2 2 60 33. 2 3 75
14. 2 2 50 34. 3 1 21
15. 2 3 69 35. 3 2 25
16. 2 1 25 36. 3 3 60
17. 2 3 75 37. 1 3 55
18. 2 3 66 38. 1 2 35
19. 2 3 65 39. 1 1 15
20. 2 2 75
Create a SPSS file as below:
15 “ANOVA-2WAY.say [DataSet1] - IBM SPSS Statistics Data Editor o | [
:iﬁ%mm“ﬂﬁaﬁﬁiﬂgﬁ%ﬂﬂﬂyr%
T T 0 | -
s e — s o | i
3 Sales Numeric 1 0 None None 1 = Right & Scale N Input
g
T
D
7
B
=
- Hl "'z

Data View | variable View

IBM SPSS Statistics Processor is ready

)-]c ¢ ¢ » 8B ¢ a|c]=]8]0] a0 |
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{3 "ANOVA-2WAY.sav [DataSet1] - [BM SPSS Statistics Data Editor = |
File Edt View Data Iransform Analze DirectMarketing Graphs Utiities Add-ons Window Help

SHEMRex BLA N EHEEBLE 190 9

[33:5ales 75 |Visible: 3 of 3 Variables

[ Temtoy | a [ ssles | war | var | var | v | var | var | v | va | var | va | var | v | w

1 1 1 20 =
2 1 3 50
3 1 2 45
4 1 2 50
5 1 3 64
5 1 1 3%
7 1 3 54
8 1 3 50
9 1 3 55
10 1 2 3%
1 2 3 65
12 2 3 65
13 2 2 60
14 2 2 50
15 2 3 69
16 2 1 2
17 2 3 75
18 2 3 66
19 2 3 65
20 2 2 75
21 3 3 75
2 3 2 30

23 3 1 35 L

|

[ |IBM SPSS Statistics Processorisready | | | | |
=15 s ¢ 5> 8 & alelelale] it

Click Analyze—> General Linear Model> Univariate...

This will open Univariate dialogue box.

Analyze DirectMarketing Graphs Utiliies Add-ons  Window

Reports Ph E;' %%

Descriptive Statistics
ar || var || var ||

Tables

Compare Means

General Linear Model [ univariate...

Multivariate.

[ Repeated Measures

Generalized Linear Models
Mixed Models

Correlate
Variance Components...

Regression
Loglinear

Neural Metworks
Classify

Dimension Reduction
Scale
Nonparametric Tests
Forecasting

Survival

* ¥ ¥ ¥ ¥F Y Y T v v v v vy w T w

Multiple Response
Missing Value Analysis

Multiple Imputation

-

Complex Samples

Quality Control 3
ROC Curve

IBM SPSS Amos...
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,
@ Univaniate @
Dependent Variable: -
= Model...
g e
f Qualification =

Fixed Factor(s)
& sales =

[«

[«

Random Factor(s):

[«

Covariate(s).

WLS Weight

]

(] () o) o)

E &

Choose Sales and send it in dependent variable box. Similarly, choose territory and
qualification and send to fixed factors list box.

"@ Univariate @

Dependent Variable: m
| & - |

Fixed Factor(s):

f Territory -
f Qualification
Random Factor(s): —

Covariate(s):

WLS Weight:

[_ok ][ Paste |[ Reset |[cancel ][ Hep |

Click Options button to open its sub dialogue box.
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+H'\ Univariate: Options

- |

Estimated Marginal Means

Factor(s) and Factor Interactions:

Display Means for.

(OVERALL)

Territary

Qualification
Territory*Qualification

Display

[/l Descriptive statistics
[+l Estimates of effect size
[/ Observed power

[T] Parameter estimates

[T] Contrast coefficient matrix

plot

[] Residual plot
[ Lack of fit

[[] General estimable function

Significance level: Confidence intervals are 95.0 %

[Continue][ Cancel ][ Help ]

Click Descriptive Statistics, Estimates of effect size, Observed power and Homogeneity tests
check boxes in the Display box and click continue. Previous dialouge box will open. Click OK to

see the output.

Between-Subjects Factors

Value Label N

1 Gandhinagar 13

Territory 2 Cosmos Town 13
3 Sadar 13

1 Under Graduate 7

Qualification 2 Graduate 14
3 Post graduate 18

Dependent Variable: Sales

Descriptive Statistics

Territory Qualification Mean Std. Deviation N
Under Graduate 23.33 10.408 3
Graduate 41.25 7.500 4
Gandhinagar
Post graduate 56.33 4926 6
Total 44.08 15.086 13
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Under Graduate 22.50 3.536 2

Graduate 61.67 12.583 3
Cosmos Town

Post graduate 66.25 7.833 8

Total 58.46 17.938 13

Under Graduate 28.00 9.899 2

Graduate 40.43 16.622 7
Sadar

Post graduate 62.50 8.660 4

Total 45.31 18.094 13

Under Graduate 2443 7.786 7

Graduate 45.21 15.636 14
Total

Post graduate 62.11 8.094 18

Total 49.28 17.899 39

Levene's Test of Equality of Error Variances2

Dependent Variable: Sales

F df1 d2 Sig.

.662 8 30 720

Tests the null hypothesis that the error variance of the dependent variable is equal across groups.

a. Design: Intercept + Territory + Qualification + Territory * Qualification

The Levene’s test shows that homogeneity of assumption has not been violated , since p>
0.05, i.e. main effects of territory and qualification are not significant. Therefore neither
territory nor qualification influences the sales by respondents.

Tests of Between-Subjects Effects

Dependent Variable: Sales

Source Type III Sum of df Mean Square F Sig. Partial Eta Noncent. Observed
Squares Squared Parameter Powerb

Corrected Model 8927.7662 8 1115971 10.314 .000 733 82.508 1.000
Intercept 62207.917 1 62207917 | 574911 .000 950 574911 1.000
Territory 515.992 2 257.996 2.384 .109 137 4.769 444
Qualification 6683.744 2 3341.872 30.885 .000 673 61.770 1.000
Territory * Qualification 635.915 4 158.979 1.469 .236 164 5.877 .399
Error 3246.131 30 108.204

Total 106894.000 39

Corrected Total 12173.897 38
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a. R Squared =.733 (Adjusted R Squared = .662)
b. Computed using alpha = .05

The above table shows that, qualification level shows significant effect on sales with p<
0.05 F=30.885, p< 0.05. The output also shows that neither territory nor territory and
qualification combined have significant interaction effect on sales with both having p> 0.05.
We can also say that, territory does not influence sales, F=2.384, p> 0.05. Also territory and

qualification both does not collectively influence sales, F=158.979, p>0.05.
» POST-HOC ANALYSIS

Click Analyze - General Linear->univariate

This will open Univariate dialogue box.

r 5
t,-'l Univariate @ b
Dependent Variable: - |
ontrasts..
Fixed Factor(s) = |
fTerritory 1
- f Qualification
andom Factor(s):
-
* -
Covariate(s):
-
WLS Weight:
'S
[ OK ][ Paste ][ Reset ][Cancel][ Help ]

Click Post-Hoc for opening Post-Hoc sub dialogue box. Select Qualification and send it in Post
Hoc Tests for list box. Click Tukey check box and click continue. Click OK to see the output.
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+H" Univariate: Post Hec Multiple Comparisens for Observed Means L&J
Factor(s). PostHoc Tests for:
Territory Qualification
Qualification
Equal Variances Assumed
£ LsD [ s-MK | waller-Duncan
[] Bonferroni [+
] sidak ] | Dunnett
[T Scheffe [] Duncan
[[] R-E-G-W-F [[| Hochberg's GT2 [ Test
] R-E-G-W-Q [7] Gabriel 9
Equal Variances Mot Assumed
[Cuntinue][ Cancel ][ Help ]
Multiple Comparisons
Dependent Variable: Sales
Tukey HSD
(I) Qualification (J) Qualification Mean Difference | Std. Error Sig. 95% Confidence Interval
(I-) Lower Bound | Upper Bound
Graduate -20.79" 4.815 .000 -32.66 -8.91
Under Graduate
Post graduate -37.68" 4.633 .000 -49.11 -26.26
Under Graduate 20.79* 4.815 .000 891 32.66
Graduate
Post graduate -16.90" 3.707 .000 -26.04 -7.76
Under Graduate 37.68" 4.633 .000 26.26 49.11
Post graduate
Graduate 16.90" 3.707 .000 7.76 26.04

Based on observed means.

The error term is Mean Square(Error) = 108.204.

*. The mean difference is significant at the .05 level.

The analysis shows that Post Graduate sales differ significantly with under graduate and

graduate sales i.e. Post Graduate and other two education levels have significant different

in sales. You can see the same results in the table below also.

Sales
Tukey HSD
Qualification N Subset
1 2 3
Under Graduate 7 24.43
Graduate 14 45.21
Post graduate 18 62.11
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Sig. 1.000 1.000 1.000

Means for groups in homogeneous subsets are displayed.

Based on observed means.

The error term is Mean Square(Error) = 108.204.

a. Uses Harmonic Mean Sample Size = 11.118.

b. The group sizes are unequal. The harmonic mean of the group sizes is
used. Type I error levels are not guaranteed.

c. Alpha =.05.

With significant interaction effects, you may see simple effects and comparison based on

graphs. The discussion ahead provides ahead provide brief about line graph results.

Click Graphs menu—> Legacy Dialogs = Line.....

This will open Line Charts dialogue box

Graphs  Utiliies  Add-ons  Window  Help

fllll Chart Builder... j (A] (%
Graphboard Template Chooser .. H (4 *")

J Legacy Dialogs } Ear... L

20 = = = [1l] 3-D Bar...

50 B Line..

45 B Area

50 B rie...

64 High-Low...

35 [ Boxplot...

> [id] Error Bar...

g: [E Population Pyramid...

35 2 Scatter/Dot...

65 Histogram...

Click Multiple and Define to open Define sub dialogue box.
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.
Q Line Charts

Simple

/|
;Oo( Multiple

IT;I Drop-line

Data in Chart Are

@ Summaries for groups of cases
Summaries of separate variables
Values of individual cases

[Define ] [ cancel || Help |

Select other Statistics radio button. By default mean will be shown , when we send Sales in box.

In Category Axis send Qualification variable and put Territory in define lines.

s
@ Define Multiple Line: Summaries for Groups of Cases

Lines Represent

@ Other statistic (e.g., mean)

Variable

© N of cases © % of cases
O cum N © cum. %

[ merngsates)

Categaory Axis:

Define Lines by:

- & Qualification

[ & Territory

Panel by

Rows:

-

[Bl st variables (no emp

Columns

r Template

[] Use chart specifications fram:

OK Paste Reset | Cancel Help
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70+

Mean Sales

40

30+

209

Teritory
— Gandhinagar
—— Cosmos Town
Sadar

T
Under Graduate

T
Graduate

Qualification

T
Post graduate

The output above shows that sales increases with increase in education in all the three

places.

kkskksk
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Chapter 7

Factor Analysis

Factor Analysis is a statistical process used to analyze interrelationships among a large
number of variables and to explain these variables in terms of their common underlying
factors. The objective is to condense the information contained in a larger number of
variable into a smaller set of variables. Factor analysis is a generic name given to a class of
multivariate statistical methods whose primary purpose is to define the underlying
structure in a data matrix. Broadly speaking it addresses the problem of analyzing the
structure of interrelationships (correlations) among a large number of variables. Once
these dimensions and the explanation of each variable are determined, the two primary
uses for factor analysis-summarization and data reduction can be achieved (Hair et
al,,1998)

Step 1: objectives of Factor Analysis
The first step involves
» ldentifying structure through data summarization

Factor analysis can identify the structure of relationship among either variables or
respondents by examining either the correlation between the variables or the correlation
between the respondents. The most common type of factor analysis is referred to as R
factor analysis. R factor analysis analyses a set of variables to identify the dimension that
are latent (not easily observed). But if factor analysis be applied to a correlation matrix of
the individual respondents based on their characteristics then it would be referred to as Q
factor analysis, which is a method of converting a large number of people into distinctly
different groups within a large population.

> Datareduction

Factor analysis can also :Identify representative variables from a much larger set of
variables for use in subsequent multivariate analyses, Or, Create an entirely new set of
variables, much smaller in number, to partially or completely replace the original set of
variables for inclusion in subsequent techniques. In both the cases the objective is to retain
the nature and character of the original variables, but reduce their number to simplify the
subsequent multivariate analysis(Hair et al.,1998)

Step 2:Designing Factor Analysis.

Hair et al, (1998) mentioned that the design of a factor analysis involves three basic
decisions:

= Calculation of input data (a correlation matrix) to meet the specified objectives of
grouping variables or respondents.
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* The design of the study in terms of number of variables, measurement properties of
variables, and the types of allowable variables; and

= Sample size necessary, both in absolute terms and as a function of number of
variables in the analysis.

Step 3: Assumptions in Factor Analysis :

Sample size :asample of 100 subjects is acceptable.

Normality  :variables should be normally distributed.

Linearity :linearity should be present since correlation are required.

Overall significance of correlation matrix should be checked with Bartlett test of sphericity
and KMO measure of Sampling Adequacy.

Step 4: Deriving Factors and Assessing Overall Fit

Hair et.al.(1998) mention that once the variables are specified and the correlation matrix is
prepared, then factor analysis can be applied to identify the underlying structure of
relationships. In doing so, decisions must be made concerning

= The method of extracting the factors ; common factors analysis versus component
analysis)
= The number of factors selected to represent the underlying structure in the data.

Component analysis to used when the objective is to summarize most of the original
information in minimum number of factors for prediction purpose. When a large set of
variables is factored, the method first extracts the combination of variables explaining the
greatest amount of variance and then proceed to combination of variables explaining the
greatest amount of variance and then proceed to combinations that account for smaller
amounts of variance.

For extracting the number of factors the latent root criterion has been used. According to
Hair et al.,(1998), the latent root criterion is most commonly used technique and its
rational is that any individual factor should account for the variance of at least single
variable if it is to be retained for interpretation. Each variable contributes a value of 1 to
the total eigenvalue. Only the factors having latent root or eigenvalues greater than 1 are
considered significant ;all factors with latent root less than 1 are considered insignificant
and are disregarded. Another criteria for the number of factor to extract is the percentage
of variance criterion which according to Hair et al.,(1998) is an approach based on
achieving a specified cumulative percentage of total variance extracted by successive
factors. The purpose is to ensure practical significance for the derived factors by ensuring
that they explain at least a specified amount of variance. The scree test is derived by
plotting the latent roots against the number of factors in their order of extraction and the
shape of the resulting curve is used to evaluate the cutoff point. Therefore, single criterion
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named latent root as a guideline for determining how many factors to extract as the first
attempt at interpretation and also a scree test to complete determination.

Step 5: Interpreting the Factors

Hair et al.(1998) explain the three steps are involved in the interpretation of the factors
and the selection of the final factor solution. The initial unrotated factor matrix is
computed to assist in obtaining a preliminary indication of the number of factors extract.
The factor matrix contains factor loadings for each variable on each factor. In computing
the unrotated factor matrix, the best linear combination of variables is expected. Therefore
, the first factor may be viewed as the single best summary of linear relationship exhibited
in the data. The second factor is defined as the second-best liner combination of the
variables; subject to the constraint it is orthogonal to the first factor. To be orthogonal to
the first factor, the second factor must be derived from the variance remaining after the
first factor has been extracted.

Factor loading is the means of interpreting the role each variable plays in defining each
factor. Factor loadings are the correlation of each variable and the factor. Loadings
indicate the degree of correspondence between the variable and the factor, with higher
loadings making the variable representative of the factor. The unrotated factor solution
may not provide a meaningful pattern of variable loadings. Generally, rotation will be
desirable because it simplifies the factor structure and it is usually difficult to determine
whether unrotated factors will be meaningful. Therefore the second step employs a
rotation method to achieve simpler and theoretically more meaningful factor solutions
(Hair et al,, 1998). In the third step, we assess the need to specify the factor model owing
to;

= Deletion of variables from the analysis

= The desire to employ a different rotational method for interpretation
* The need to extract a different number of factors

= The desire to change from one extraction method to another.

Re-specification of a factor model is accomplished by returning to the extraction stage,
extracting factors, and interpreting them again(Hair et al.,1998)

According to Hair et al. (1998) three major orthogonal approaches have been developed

QUARTIMAX: the ultimate goal of a QUARTIMAX rotation is to simplify the rows of a factor
matrix ; that is QUATRIMAX focuses on rotating the initial factor so that a variable loads
high on one factor and as low as possible on all other factors.

VARIMAX: VARIMAX criterion centres on simplifying columns of the factor matrix. With
the VARIMAX rotational approach, the maximum possible simplification is reached if there
are only 1s and Os in a column.
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EQUIMAX: the EQUIMAX approach is a compromise between the QUARIMAX and
VARIMAX approaches. Rather than concentrating either on simplification of the rows or on
simplification of the columns, it tries to accomplish some of each.

In selecting among the above mentioned rotational methods for the research , there is a
point to mention that no specific rules have been developed to guide the researcher in
selecting a particular orthogonal or oblique rotational technique. In the working example
we intend to utilize the rotational technique VARIMAX as the orthogonal solution for the
analysis of existing variable.

» WORKING EXAMPLE:

The researcher wants to conduct factor analysis on the factors affecting the employee
satisfaction.

Eleven variables were considered for conducting factor analysis. He conducted analysis
based on the rating: strongly disagree(1), disagree(2), Neutral (3) ,Agree (4), Strongly
agree (5)

Make a data file based on the eleven factors as shown in the figure below:
1 Uttt [Dotaet T 955 Sttt Ot i A | - S

File Edit View Data Transform Analyze DirectMarketing Graphs Utiliies Add-ons Window Help

SHE e~ B B BOE 00

Name Type Width | Decimals Label Values Missing Columns Align Measure Rale
1 VAR00001 Numeric 8 2 Nane None 8 = Right Unknown v Input =
2 VAR00002 Numeric 8 2 None Mone 8 = Right Unknown v Input
3 VAR00003 Numeric 8 2 Nane None 8 = Right Unknown N Input
4 VAR00004 Numeric 8 2 Nane None 8 = Right Unknown N Input
5 VAR00005 Numeric 8 2 Nane None 8 = Right Unknown N Input
6 VAR00006  Mumeric 8 2 Nane None 8 = Right Unknown N Input
7 VAR00007 Numeric 8 2 None Nene 8 = Right Unknown v Input
8 VAR00008 Numeric 8 2 Nane None 8 = Right Unknown N Input
9 VAR00009 Numeric 8 2 Nane None 8 = Right Unknown N Input
10 VAR00010 Numeric 8 2 Nane None 8 = Right Unknown N Input
" VAR00011 Numeric 8 2 Nane None 8 = Right Unknown N Input

12
13
14
15
16
17
18
19
20
21
22
23
24
25

[l

E1I I¥]

Data View  Variable View

IBM SPSS Statistics Processor is ready

- P 6 %02am

Respondents | Var Var | Var Var | Var | Var | Var | Var | Var | Var | Var
1 2 3 4 5 6 7 8 9| 10| 11

L. 4 4| 4 4| 4| 5| 3| 5| 5| 5| 5

5 5 5 4 5 5 4 4 5 5 4

3. 3 4| 4 5| 4] 5| 4| 5| 5| 4] 4
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10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

22.
23.
24,
25.
26.
27.
28.
29.
30.
31.

32.
33.
34.
35.
36.
37.
38.
39.
40.

41.

42.
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43.

44,

45,

46.

47.

48.

49.

50.

51.

52.

53.

54.
55.

56.
57.
58.
59.
60.

61.

62.

63.

64.
65.

66.

67.

68.

69.

70.
71.

72.

73.

74.
75.
76.

77.

78.

79.
80.

81.
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82.

83.

84.
85.

86.

87.

88.

89.

90.

91.

92.

93.

94,
95.
96.

97.

98.

99.

100.

101.

102.

103.

104.

105.

106.

107.

108.

109.

110.

111.

112.

113.

114.

115.

116.

117.

118.

119.

120.
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121.

122.

123.

124.

125.

126.

127.

128.

129.

130.

131.

132.

133.

134.

135.

136.

137.

138.

139.

140.

141.

142.

143.

144.

145.

146.

147.

148.

149.

150.

151.

152.

153.

154.

155.

156.

157.

158.

159.
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160. 5 5 5 5| 4| 4| 4| 4| 5| 4| 4
161. 1 1 1 1| 1| 1] 1| 1| 1| 1| 1
162. 1 1 1 1 1| 1] 1] 1] 1| 1| 1
163. 1 1 1 1| 1| 1] 1| 1| 1] 1| 1
164. 2 4 4 5/ 1| 4| 4| 3| 4| 2| 4
165. 3 3 2 2| 3| 5| 4| 3| 4| 3| 4
166. 3 4 5 5| 4| 3| 5| 5| 2| 2| 5
167. 4 4 4 4| 5| 5| 4| 3| 4| 4| 4
168. 4 4 4 4| 5| 5| 4| 3| 4| 4| 4
169. 4 4 4 4| 5| 5| 4| 3| 4| 4| 4
170. 2 2 2 3/ 5/ 5| 1| 1| 5| 1| 3
171. 2 3 3 3/ 3| 3| 2| 1| 5| 2| 4
172. 3 2 2 3] 4| 1] 3| 2| 1| 2| 3
173. 4 5 5 5| 5| 4| 5| 4| 4| 5| 5
174. 5 5 3 4| 5| 4| 5| 4| 5| 3| 5
175. 5 3 4 5| 3| 4| 5| 5| 4| 3| 5

Click Analyze - Dimension Reduction Factor.......

This will open Factor Analysis dialogue box.
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@ *Untitled? [DataSetl] - [BM SPSS Statistics Data Edif s

File Edt View Data Transform Analyze DirectMarketing Graphs Utilties Add-ons Window Help

0 F - Reports » L] % ‘
H E;j e Descriptive Stafistics » md %
| Name u Type Tables y abel u Values ” Missing H Columns H Align H Measure H Role ‘
1 VAR00001  Numeric Co&pave Weans v None None 8 Right Unknown  Input
2 VARQ0002  Numeric GeneralLinear Hodel s None MNone [ Right Unknawn N Input
3 VARQ0003  Numeric GeneralzsdLinear Hodsls ) None Mone L] Right Unknawn  Input
4 VAR00004  Numeric ised Models , None Mone 8 Right Unknawn N Input
5 VAR00005  Numeric Cu-rre\ale 5 None None 8 Right Unknown N Input
6 VARO0006  Numeric - None None 8 Right Unknown N Input
7 VAR00007  Numeric Regression ' None None 8 Right Unknown  Input
8 VAR00008  Numeric Laginezr ' None None 8 Right Unknown  Input
9 VARQ0009  Numeric LELEELS ' None Mone 8 = Right Unknown ™ Input
0 |VAROOIO  Numeic | S 4 None Hone 8 Rght  Unknown N Input
11 |VARDOOM  Numedc |  DimemsionReducion bl 8 paciyr 8 Rght  Unknown N Input
12 Saale 4 [ Corespondence Analysis
13 Nonparametric Tesis » gj Qptimal Scaling.
1 Forecasting »
15 Survival »
16 luftiple Response »
17 [0 issing Valug Analysis...
18 Hultiple Imputation »
19 Complex Samples »
2 Quality Control )
2 ROC Cune..
2
A}
il
2% &
il [
w Variable View
|Dimension Reduction IBM SPSS Statisics Processoris ready | |

8 vtz e 5 s o T . - 6| |

File Edit View Data Transform Analyze DirectMarketing Graphs Utilties Add-ons Window Help
0%
md %

SHeERe~ BLE i B BO

| Name H Type H Width H Decimals H Label H Values H Missing H Columns H Align ‘l Measure ‘l Role ‘

1 VAR00001  MNumeric 8 2 Mane None 8 = Right Unknown N Input
2 VAR00002  Mumeric 8 2 None MNone 8 Right Unknown N Input
3 VAR00003  Mumeric 8 2 Mane None 8 Right Unknown N Input
4 VAR00004  MNumeric 8 2 Mane None 8 Right Unknown v Input
g VAR00005  |Numeric 8 2 - bl Ll = Rioht Linky < N input
6 |VARDD00G  Numeric 8 2 8 Factor Analysis - . @ - [ N Input
7 VAR00007  Numeric 8 2 Variables w N Input
VAR00008 ' Mumeric 8 2 ‘ VARD0001 ‘ N Input
9 VAROOOO9 Numeric 8 2 & VARO0002 (_gacton.. | “ Input
0 |VAROOOI0  Numeric |8 2 gVARUUOM m v Input

VARODDO4
" VAR00011  Numeric 8 2 E sﬁiﬁs N Input
= & VARDDOOS P

7 vawor Lo |
13 & VARDD0OT
e o VaR00008 Selection Variable:
1 & VARD000S E
= & VARDDD10
& VARDDD11 Value

7 -
18
19
2 Y Y Y Y y
pal
2
k]
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Click the variable in the left list box and send it in Variables list box by clicking upper right
arrow button. Similarly do this for other variables. Click Descriptives... button to open its
sub dialogue box and select the desired statistics as well as correlation matrix properties
according to your need. In the working example, we have selected KMO and Barlett’s test
of sphericity as well as Anti-image in the correlation matrix. Click Continue button to
close the sub dialogue box. The previous dialogue box will reappear.

8 vz s - 55 b ™ p = SIS

Flle Edt View Data Transform Analze DirectMarkeing Graphs Utiities Add-ons Window Help

SHEH e~ BLAhBY EBLE 100 %

Name Type Width | Decimals Label Values Missing | Columns Align Measure Role H
1 VAR00001  Numeric 8 2 None None 8 ht Unknown ~ Input =
2 VAR00002  Numeric 8 2 None None 8 ht Unknawn ~ Input
3 VAR00003  Numeric 8 2 None None 8 ht Unknawn ~ Input
4 VAR00004  Numeric 8 2 None None ] ht Unknawn ~ Input
5 VAR00005  Numeric 8 2 - I L Rinht Linka ~ Input
6 VAR00006  Numeric 8 2z @ Factor Analys 12 Factor Analysis: Descriptives =5 = N Input
7 VARO0007  Numeric 8 2  Input
8 'VAR00008  Numeric 8 2 & VARDDODA Statistics @ N Input
9 'VAR00009  Numeric ) 2 & VARDDDD2 [ Univariate descriptives Exraction. N Input
10 |VARDOOT0  Numeric 8 2 gvmnnnns [+ Initial solution Rotation N Input

VAR0D0D4
1‘; VARDOD_ Numere s ? & VARD0005 | | -Correlation Marix @ > Input
= DAl [ESI Ne P . optens..|
m & VARO000Z [ significance levels [ Reproduced
T3 & VARD0DDS [] Determinant [] Antiimage
5 & VARD0D10 [¥1}KMO and Barllett's test of sphericit
7 & VAR00D11
19
20
21
2
2
2
2 i
[ETI 3]

IBM SPSS Statistics Processor s ready

Click Extraction.... Button to open its sub dialogue box. Select the method as principal
components. You can also change other extraction methods and options as per you need.
In the working example, we have selected the following extraction options. Click Continue
button to close the sub dialogue box. The previous dialogue box will reappear.
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1 et s 55 s oo T T I - O :

File Edt View Data Transform Analze DirectMarketing Graphs USilties Add-ons Window Help

SR H e BhI B BLE 109

Name
VARD0001
VARD0002
VAR00003
VARD0004
VAR0000S
VARD0006

7 VAR000O

8 VAROODS
9 VAR0D009

10 VARDOO10
11 VAROOO1

12

13

0

15

16
e

1

19

2

21

2

2

@ o s w

Type
Numenc
Numeric
Numenc
Numenc
Numenc
Numeric
Numenic
Numenc
Numenc
Numenc
Numenc

™ o »m ™ ®m ®mw ™ m m ®

Width | Decimals|  Label

[ R O R N A N R IS

Valves Missing | Columns Algn

4

Measure Role

None None 8 3 Right Unknown N Input
None None 8 = Right Unknown N Input
None None 8 = Rgh Unknown N Input
13 Factor Analysiz: Extraction . | B N Input
oot — L. Ninput
Metod Principal components  ~ N Input
Analyze Display N Input
® Correlation matrix ¥ Unrotated tactor solution  Input
© Covariance matrix ¥/ Seree plot  Input
v Input
Exract N nput
® Based on Eigenvalue )
Eigenvalues greaterthan [1 |
© Fixed number of factors
Factors to exract
Mamu herations for Convergence: [109] |
(cootoue)_conet || |3

A1

1BM SPSS Statistics Processor is ready

Click Rotation ... button to open its sub dialogue box. Select the method as Varimax and
in Display select the check box of Rotated solution. Click Continue button to close the
sub dialogue box. The previous dialogue box will reappear.
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File Edit View Data Transform Analyze DirectMarkefing Graphs Utiliies Add-ons Window Help
10 9®
md %

SHe M e~ B2 H BE BS

| Name H Type ‘l Width H Decimals ‘l Label ‘l Values H Missing H Columns ‘l Align ‘l Measure ‘l Role |
1 VAR00001  |Numeric 8 2 None None 8 = Right Unknown N Input
2 VAR00002  Numeric 8 2 None None 8 Right Unknown N Input
k3 VAR00003  Numeric 3 2 None Mone g Right Unknawn N Input
4 VAR00004  Numeric 3 2 None None 8 Right Unknown N Input
5 VAR00005  |Numeric 8 2 Mons. None. _ﬂm_AUakTm_[ N Input
6 |VARODOOE  Numeric 8 2 8 Fector Analf ) Factor Analysis: Rotation ] N Input
7 VAR00007  |Numeric 8 2 N Input
5 |VAROOOS  MNumerc 8 2 7 ViR ] Al N Input
9 VAR00009  Numeric 8 2 & VAR000G © None © Quartimax m N Input
10 VAROOMO  Numeic 8 2 & varonof| | ©Yermer O Equamax e Input
11 VAR000T!  Numeric 3 2 & varooog)| | © Direct Gblimin @ Promax N Input
= & varooog)| | Deta o Kappa |4 |
& varo00q)|
13 & R00OY| pisplay
12 g ;ﬁggz: { [ Rotated solution [ Loading plats) ‘
|
1§ ﬁxﬁggg Maximum Iterations for Convergence:
T (cone cance | |
19 S
20
21
22
23
24
25 |
[l [H]

[ IBM SPSS Statistics Processoris ready | |

Click Scores... button to open its sub dialogue box. select the scores according to your need.
Click Continue button to close the sub dialogue box. The previous dialogue box will
reappear.

8 "tz st o 955 s o oo T =5 =

File Edit View Data Transform Analyze DirectMarketing Graphs Utiities Add-ons Window Help
190 %
[d %

SHe M e~ BLA HEE B

Name | Type | Width | Decimals | Label | Values | Missing | Columns|  Algn | Measure |  Role
1 VARO0001  Numeric 8 2 Mone None 8 Right Unknown N Input
2 VAR00002  Numeric 8 2 None Nane 8 Right Unknown N Input
3 VAR00003 MNumeric 8 2 None None 8 Right Unknown “ Input
4 VAR00004  Numeric 8 2 Hone None 8 Right Unknown N Input
5 VARO0005  Numeric 8 2 ﬂw;@&wﬂ% . Input
6 VAR00006  Mumeric 8 2 12 Factor Analysis . - “ Input
7 VARO0007  Numeric 8 2 (Y Y —— | N Input
8 'VAR00008 Mumeric 8 2 & VARDO0O1 “ Input
9 VAR00009  Numeric 8 2 & vAR00002 | | [liSave as variables; ™ Input
10 VAR00010  Numeric 8 2 & VAROD003 N Input
1 VARD00T!  Mumeric 8 2 & VAR0D00S v Input
= & VARD000S

& VARODO0G
13 & VAR000OT
14 & VARDDD0B
15 & VAR00009 | | ] Display facter score coeflicient matrix
] S e
18 ” = TER
19
20
21
22
23
24
25 =
[T [F]

T [IBM SPSS Statistics Processoris ready | | | | |
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Click Options...button to open its sub dialogue box. Select the options according to your
need. Click Continue button to close the sub dialogue box. The previous dialogue box will

reappear. Click Ok to see the output viewer.

13 “Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor I

File Edit View Data Transform Analyze DirectMarketing Graphs Ulilities Add-ons Window Help

T - 0 |

%Hw Me~BLEARAES S50 100 %)

Name H Type || Width ‘l Decimals ‘l Label H Values || Missing H Columns H Align H Measure H Role
1 VAR00001 Numeric 8 2 Mone None 8 = Right Unknown N Input
2 VAR00002  Mumeric 8 2 Mone Mone 8 = Right Unknown N Input
3 VAR00003  Mumeric 8 2 Mone None 8 = Right Unknown N Input
4 VAR00004  Mumeric 8 2 Mone None 8 = Right Unknown N Input
5 VARQ0005  Mumeric L] 2 bona blone = Rinht Linknowin N Input
6 VARDDDOS Numeic 8 2 8 Factor Analyl 16 Factor Analysis: Options = N Input
i VAR00007  Mumeric 8 2 ] N Input
B VARDOE  Memeric B 2 P | [ N Input
9 VAR00009  Mumeric 8 2 & VARDDOO! ® Exclude cases listwise N Input
10 |VARODD1D Mumeric 8 2 & VAR O Exclude cases painwise N Input
11 VARODOM  Numerc 8 2 & varoooof| | © Replace with mezn e Input
5 # vARD00D!

rCoefficient Display Format Options

£ & VARDOOD [7] Sorted by size
14 & VARDDOOS .
= & VAR0000! [l Suppress small coefiicients
= & VARDODA Absolute value below:
— & VAR00D1
-
13 _—
20
il
2
23
24
25

o1

KMO and Bartlett's Test
Kaiser-Meyer-Olkin Measure of Sampling Adequacy. .882
Approx. Chi-Square 1179.049
Bartlett's Test of Sphericity df 55
Sig. .000
Communalities
Initial Extraction
VAR0001 1.000 .595
VAR0002 1.000 .759
VAR0003 1.000 704
VAR0004 1.000 737
VAR0005 1.000 .658
VAR0006 1.000 774
VAR0007 1.000 425

|IEM SPSS Statistics Processor is ready \ ‘ | ‘ ‘

< B F ) 9AM
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VAR0008 1.000 .594
VAR0009 1.000 .587
VAR00010 1.000 704
VAR00011 1.000 .587
Total Variance Explained
Compone Initial Eigenvalues Extraction Sums of Squared Loadings | Rotation Sums of Squared Loadings
nt Total % of | Cumulative | Total % of Cumulative % | Total % of Cumulative
Varianc % Variance Variance %
e
1 6.119( 55.630 55.630| 6.119 55.630 55.630| 4.811 43.734 43.734
2 1.004 9.126 64.755| 1.004 9.126 64.755| 2.312 21.021 64.755
3 920 8.364 73.119
4 .636 5.782 78.901
5 527 4.795 83.695
6 482 4.381 88.077
7 411 3.733 91.810
8 .318 2.894 94.704
9 .235 2.135 96.839
10 190 1.726 98.565
11 .158 1.435 100.000
Extraction Method: Principal Component Analysis.
Scree Plot

Eigenvalue

Component Matrix2

Component

1 | 2

Component Number
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VARO0001
VAR0002
VARO0003
VAR0004
VAR0005
VAR0006
VAR0007
VAR0008
VAR0009
VAR00010
VAR00011

.759
.860
.789
.836
796
533
.649
679
.648
825
762

.699

Rotated Component Matrix2

Component
1 2
VAR0001 724
VAR0002 813
VAR0003 825
VAR0004 821
VAR0005 765
VAR0006 873
VAR0007 531
VAR0008 .658
VAR0009 .680
VAR00010 .788
VAR00011 .697
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» EXERCISE

80 Respondents were surveyed based on 15 variables with a rating scale of :

Strongly disagree-1, Disagree-2, Neutral-3, Agree-4, Strongly Agree-5.

Conduct a factor analysis based on the following data table and conclude the results of output.

Var

15

Var

14

Var

13

Var

12

Var

11

Var

10

Var

Var

Var

Var

Var

Var

Var

Var

Var

Respondents

10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

22.

23.

24.
25.
26.
27.
28.
29.
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30.
31

32.

33.

34.
35.
36.
37.
38.
39.
40.

41.

42.

43.

44,

45.

46.

47.

48.

49,

50.

51.

52.

53.

54.
55.

56.
57.

58.
59.
60.

61.

62.

63.

64.
65.

66.

67.

68.
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69.

70.
71.

72.

73.

74.
75.
76.
77.

78.

79.
80.
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THANKYOU

DR.SHINEY CHIB
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